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01	 General

1.1	 About the document

The document relates to Architecture FLX - Multisite - 
Release 2.1 connected lighting system.

This document describes functionality of the user 
interface and how to operate it.

1.2	 Intended audience

The information in this guide is specifically intended for 
System Centers, installers, site engineers, and customer 
IT departments.

The instructions are placed in logical chapters and in 
chronological order. When following the procedures 
meticulously, you must be able to design, install and 
commission a functioning lighting system.
 

1.3	 Related documents

Refer to other documents for more information:
•	 System Guide
	 describes the system design and how this design  

can support the requirements of a customer.
•	 User Guide
	 describes the usage of the Interact Multisite System 

Manager  dashboard and user pages, that are 
specifically aimed at facility managers and format 
managers.

•	 Security Statement
	 describes end-to-end system security that 

guarantees data confidentiality, integrity, and 
availability.

•	 Project intake form (Project template) 
	 guides and simplifies the onboarding process of a 

customer and a new site to Interact Multisite System 
Manager.

•	 Bill of Materials
	 overview of all components and their 12nc  

ordering codes.
•	 Technical Note
	 provides information with a focus on additional tasks 

that require attention only once.
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1.4	 Abbreviations

The following abbreviations are used throughout the document:

Abbreviation Explanation

BLA Base Link Area

BMS Building Management System

BoM Bill of Materials

DALI Digital Addressable Lighting Interface communication protocol

DMX Digital MultipleXed communication protocol

DSI Digital Serial Interface communication protocol

HVAC Heating, ventilation, and air conditioning

IR Infrared

PDDEG-S Philips Dynalite DIN-rail Ethernet Gateway – Supervisor (in short: Site Gateway)

PDSE Philips Dynalite Site Enabler app (in short: Site Enabler app)

PDEB Philips Dynalite Ethernet Bridge (in short: Ethernet Bridge)

PDEG Philips Dynalite Ethernet Gateway (in short: Ethernet Gateway)

PE Photo electric

PIR Passive Infrared

PWM Pulse-Width Modulation phase cut dimming

STP Shielded Twisted Pair

UI User interface

Abbreviation Explanation

BSR Business Support Request

C4CS Ticketing system capturing 
customer tickets

C-ROC Signify Customer Remote 
Operating Center

C-SAT Customer Satisfaction

CSI Customer System Integrator

GSO Global Software Operations

OTRS Ticketing system capturing 
corporate tickets

SAP Enterprise software for customer 
management
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1.5	 Terms and definitions

The following terms and definitions are used throughout the document: 

Term Definition

Format A group of sites with similar design or style (In retail 
also known as the formula). Every site belongs to only 
one format.

Area A lighting control area (for example Sales floor  
or Back of house)

Base Link Area A Base Link Area in System Builder corresponds with 
an lighting control area at the site.

Scene A specific set of light levels that can be edited  
and recalled

Child area A lighting control zone (like Bakery or Fresh food) 
included inside an Area (for example Sales floor)

Logical channel A lighting control sub-zone included inside a Child 
area (like Bakery spots or Bakery counter)

Concepts Light concept including the defined areas, scenes, 
child areas, logical channels etc. to be used in a 
format

Schedules Set of all scheduled events (simple events, special 
events, holidays) that automatically control the 
lighting of the sites in a specific format

Term Definition

Astronomical 
timeclock

The ability to control and schedule the light levels 
depending on sunrise and sunset times  
(day and night mode)

Deployment A concept and schedule ready for transfer to either 
one site or multiple sites

Draft (state) Deployment in preparation

Deployed (state) Deployment in use

Archived (state) Deployment no longer in use

Online status Shows whether the Site Gateway is online or offline

Not requested No workorders available; site not in  
execution phase

Under 
preparation

Workorders created and execution phase  
in progress

Operational Workorders are resolved/closed, site operational

Subscription Actual status of the contract(s) and license(s)

(Not) deployed Shows whether the site is functional (or not)
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1.6	 Symbols

The dashboard user interface (UI) uses intuitive symbols 
and colors. The overview shows an overview of the 
colors and symbols used.

Item Definition

  /  Critical issue, requires immediate attention

  /  Minor issue, requires attention

  /  Status OK

     In progress, a process is running in the background

  /  Filter, hover over the icon to show a selection to limit the 
output on the screen; shows in color in case a filter is 
applied

  /  Sort, click to sort the output on the screen respectively 
ascending or descending; in case sorting is applied, the 
colored arrow shows the direction of the sorting

       
Action menu, click to show actions related to the purpose 
of the page

       Rotating wheel, indicating that an action is in progress  
(for example collection data to show)

Item Definition

    /  Notification, messages important for the user, for
example upcoming server maintenance; The green dot 
indicates that new items are available

 /  Additional information dropdown. The green dot indicates 
that new items are available

         User profile, language selection

    /    Expand/collapse the side menu, in expanded view, also the 
menu name shows
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2.1	 System architecture

The Multisite system offers remote and centrally 
managing of lighting systems in multiple sites. This 
enables people working at the headquarters of a brand 
possibilities in managing the brand promise over the 
stores, differentiating over different formats of the brand.

The architecture is characterized by two distinguished 
parts:
•	 Connected architecture
•	 Onsite architecture

2.1.1 	 Connected architecture

Cloud and gateway
The Site Gateway (PDDEG -S) functions as the 
central ‘store controller’, interconnecting the onsite 
architecture and safeguarding secure cloud connection. 
With the gateway being online, and a fully commissioned 
system, everyone with sufficient access rights can 
remotely monitor and control and see the data 
generated by the site in the dashboard. This data is  
safely stored in the Interact cloud.

Connectivity service
The Site Gateway requires outbound internet access  
to send all data to the cloud. This access can be  
provided by:
•	 Customer IT
	 Arranges access to the Interact cloud via the 

internet according to the specifications via the IT 
infrastructure of the site.

•	 IAR Connectivity Service
	 Connectivity service using a 4G modem managed  

by Signify.

	 Note
The Interact Connectivity Toolbox simplifies the audit 
of the onsite IT infrastructure, validating if it is ready 
to install Multisite system components.
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Retail operations portal
Onboarding and managing all the customers, sites, users, 
licenses, etcetera is done via the Retail operations 
portal. Dependent of the nature of the task, the handling 
is done by either Global Software Operations (GSO) or 
the Customer Remote Operating Center (C-ROC).

Remote monitoring services
By default, the following remote services and support 
are offered:
•	 Helpdesk and service ticketing
•	 Regular software and firmware updates via cloud
•	 Remote uptime monitoring of all your sites
•	 Quarterly performance report
•	 Annual remote system health check - controller 

& light points health, report includes optimization 
suggestions

•	 Access to your customer portal for all documentation

Remote operation services
Signify optionally also offers remote operations 
lifecycle services. In this case the Signify Customer 
Remote Operating Center (C-ROC) maintains the high 
performance of your connected system over the full 
lifetime through our comprehensive remote service 
package:
•	 We adjust your light upon your needs
•	 Light levels & schedules bulk updates of all your 

stores of one format in one go 
•	 Remote system optimization
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Licenses
A license subscription is required to get full access to 
the rich set of multisite features and historical data.

Without license:
•	 Lighting in all your sites continues to operate
•	 Local lighting control in every site keeps running
•	 Read-only access to the multisite dashboard
•	 Over-the-air security software updates to the cloud 

and your Site Gateways
•	 Storage of historical data for 90 days after expiry

With license also:
•	 Remote lighting control
•	 Remote system health features
•	 Remote energy monitoring features
•	 Remote technical support.
•	 Alerts and reporting features.
•	 Local control to adjust lighting of your site(s).

2.1.2 	 Onsite architecture
The Multisite system currently operates onsite with the 
following Store topology:
•	 Wired

The Site Gateway (PDDEG -S) functions as the central 
‘store controller’, interconnecting the onsite hardware.

The correct combination of controls hardware creates a 
robust controls network enabling:
•	 Scene control with dimming & zoning with addressable 

DALI support
•	 Support for DALI Broadcast, switched lighting, plus 

optional phase, phase cut dimming (PWM), DMX, 
0-10V/1-10V dimming

•	 Daylight & occupancy sensing to dynamically adjust 
lighting to local conditions 

•	 Local manual override, plus integrations with Building 
Management Systems (BMS), alarm systems, HVAC

	 2.1	 System architecture
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Figure 1. Offering central scene management, lighting management and energy optimization to the local sites via the cloud

	 2.1	 System architecture

Secure Site Gateway 
and lighting controls network

Interact Cloud and application

Site(s)

Lighting Sensors User interfaces

Scene 
management

Energy 
optimization

Lighting 
management

Remote 
service

BMS

HVACAlarm systems
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Wired topology
In the wired infrastructure, the Gateway connects to the 
control equipment by means of DyNet wiring. Luminaires 
are connected to the load controllers, depending on 
the type of luminaire by means of power and/or control 
cables.

	 Important
The power supply to the PDDEG-S Ethernet Gateway 
must be continuously available. It’s not allowed to 
switch off the device during the night.

	 2.1	 System architecture

optional

Dry Contact
Integration

Device
(e.g. for BMS)
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DDRC420
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Sensor

DDBC1200 DDRC1220DDBC120 DALI

PDDEG-S

4G

PDTS

DDBC320 DALI
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2.1.3	 Metered energy topologies
Energy metering requires per metered group an 
extension of the topology to connect an energy meter. 
During commissioning, the meters must be added to 
the System Builder job file and assigned to the correct 
groups to enable reporting of the energy consumption to 
the cloud.

The feature can be enabled using the following 
extensions of the topology:
•	 Adding an Ethernet Bridge (PDEB) or Ethernet 

Gateway (PDEG) to enable metering using Modbus 
over RS-485.

•	 Using the ethernet connectivity of the site gateway 
(PDDEG-S) to enable metering using Modbus over IP.

•	 Adding a RS-485 Gateway (DDNG485) to enable 
metering using Modbus over RS-485.  

	 2.1	 System architecture
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Using Modbus over RS-485 via a PDEB or PDEG
Using Modbus over RS-485 via an Ethernet Bridge 
(PDEB) or Ethernet Gateway (PDEG), the signals from the 
Energy Meter are transmitted using the Modbus RS-485 
protocol to the Ethernet Bridge or Ethernet Gateway, 
which device translates it to Dynet over IP and transmits 
it to the Site Gateway (PDDEG-S). The distribution 
switch is required as the Site Gateway has only a single 
RJ45 Ethernet connection, and this device also needs 
connection with the cloud.

PDDEG-S

Energy Meter

Distribution switch

PDEB/PDEG

Load controllerLoad controller

Dynet/IP

Dynet/IP

RS-485

Dynet/RS-485

Topology of metering over RS-485 via PDEB or PDEG

	 2.1	 System architecture
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Using Modbus over IP via the Site Gateway
In the case of using Modbus over IP, the signals from 
the Energy Meter are transmitted directly to the Site 
Gateway (PDDEG-S). The distribution switch is required 
as the Site Gateway has only a single RJ45 Ethernet 
connection and also needs connection with the cloud.

Topology of metering over IP via PDDEG-S

PDDEG-S Distribution switch

Load controllerLoad controller

Dynet/RS-485

Energy Meter

Modbus/IP

Modbus/IP

	 2.1	 System architecture
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Using Modbus over RS-485 via a DDNG485
Using Modbus over RS-485 via a RS-485 Gateway 
(DDNG485), the signals from the Energy Meter are 
transmitted directly from the RS-485 Gateway to the 
Site Gateway (PDDEG-S) using the RS-485 protocol. In 
this topology, a distribution switch is not required.

Topology of metering over RS-485 via DDNG485

PDDEG-S

Load controllerLoad controller

Dynet/RS-485

Energy Meter

Modbus/RS-485

DDNG485

	 2.1	 System architecture
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2.2	 IT requirements

The system and related software require some basic 
settings for the optimal performance.

2.2.1 	 IT settings
The system requires the following ports to be open for 
outbound traffic only:
•	 53 (DNS)
•	 123 (NTP)
•	 443 (HTTPS)
•	 5671 (MQTT or AMQP)
•	 8883 (MQTT or AMQP)

A connectivity test tool is available to check the 
connection at the site of the customer upfront of 
installation and commissioning.

See the FLX Multisite Security Statement for more 
information about the requirements concerning the  
IT settings. 
 

2.2.2	 Requirements for the dashboard
The following web browsers support usage of the 
dashboard:
•	 Google Chrome
•	 Microsoft Edge
	 (Chromium based versions 75 and higher)
•	 Mozilla Firefox
•	 Apple Safari

	 Note
For performance and security reasons it’s best to 
always use the latest version of the selected web 
browser.

You can view the dashboard properly on screens with 
a resolution of 1024x768 dpi, but a higher resolution is 
recommended.
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2.2.3 	 Requirements for the site enabler app
The site enabler app (Philips Dynalite Site Enabler app) 
is available for use on mobile devices running on Android 
or iOS. The following versions of the operating system 
support the usage of the Site Enabler app:
•	 Android 9.0 (64-bit) or higher
•	 iOS 13.0 or higher

2.3	 System configuration

The Multisite system is designed to get the full potential 
out of the DALI control infrastructure. The selection of 
the controllers also defines the control method:
•	 DALI broadcast
•	 DALI addressable

The table shows the differences between the control 
methods.

addressable broadcast

Scene and schedule management

Scenes Scenes

Schedules Schedules

Flexible rezoning 
(independent of wiring)

Energy monitoring

Notional 
(verified over lifetime)

Notional

Smart meters Smart meters

Metered DALI

Lighting management

Store online/uptime 
monitoring

Store online/uptime monitoring

System health 
(controllers/sensors)

System health 
(controllers/sensors)

Preventive maintenance Preventive maintenance 
(notional)

Light point status
(failure/burning hours)
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The aim of the intake is to allow to tailor the solution 
exactly to the customer. What are his exact demands 
and how should the lighting system be engineered. For 
this it’s important to have some knowledge of the theory 
behind the system.

3.1	 Formats

With Multisite, it’s possible to control lighting scenes, 
schedules, and behavior for the different areas 
independently. The combination of settings is defined in a 
format, That is tailored for deployment to a specific retail 
format.

3.1.1	 Retail formats
The Multisite system is suitable for all kinds of retail 
formats:
•	 Convenience: Smaller local stores and express 

formats
•	 Supermarket: Larger supermarkets and DIY retails
•	 Hypermarket: Very large out of town and department 

stores
•	 Distribution centers: warehouses and dislocated 

pick-up points
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3.1.2	 Areas and Scenes
Per retail format the Areas are defined at a high level. 
Depending on the size of the format, it’s possible to 
define multiple areas. Examples of areas:
•	 Sales floor
•	 Back of house
•	 Outdoor

For each area, the Day & Night Mode can be selected 
for lighting to follow sunrise and sunset. Day and night 
are determined using the astro-clock functionality on 
the Site Gateway, which applies the Day settings after 
sunrise, and the Night settings after sunset. This is 
especially handy for areas that control outdoor lighting.

Each area consists of several Scenes. The scenes define 
the light settings for a specific moment in each area 
at the site at the site. This to facilitate the different 
activities at the site. Examples of scenes are:
•	 Trading/Trading Eco
•	 Stocking
•	 Cleaning
•	 All Off
 

3.1.3	 Child areas and Logical channels
In general, the areas are too big to have sufficient 
control over all the lighting. For this purpose, the lights in 
the area are divided into different control zones, the so-
called Child areas. These child areas are smaller groups 
of lights that can have their own setting in the area. For 
the area Sales floor, some examples for child areas are:
•	 Bakery
•	 Meat
•	 Cash registers
•	 Etcetera

To be able to have more detailed control of the lights 
in the child area, it’s necessary to assign the lights to 
different Logical channels. These logical channels help 
to divide the lights over the different usages of the lights 
at the site. For example, you can create logical channels 
for linear lighting, downlights, or for spot lighting.

In simplified use cases, where the child area only has one 
logical channel, you can give this logical channel the same 
name as the child area.

	 3.1	 Formats
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3.1.4	 Concepts and Schedules
With Concepts you define for each scene the actual light 
settings (dim level and, if applicable, also color) at each 
logical channel. Once defined, a particular scene can 
easily be recalled or triggered for an entire area.

To automate the behavior of the lighting system, you can 
specify Schedules. A schedule defines for each separate 
area the times that specific scenes are activated over 
the course of a 24-hour cycle. It is possible to define 
different schedules for different types of events:
•	 Simple event: a 24-hour schedule that occurs often, 

for example normal weekdays or weekends.
•	 Holiday: one or more recurring days that allow for 

their own 24-hour schedule, for example (national) 
holidays (site can also be closed).

•	 Special event: a 24-hour schedule that occurs only 
one time. A special event can span multiple days and 
can be used for opening hours that are applicable 
for special occasions, for example during a special 
season.

Figure 2. Calendar view showing the days and dates the 
specific schedules apply to.

	 3.1	 Formats
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3.2	 Users and user roles

Below an overview of the users and the user roles that 
have interaction with System Designer and Interact 
Multisite System Manager. Note that there’s a clear 
distinction between users handling offsite and onsite 
taksk. See Appendix B Roles and responsibilities for more 
information.

3.2.1	 Users handling offsite tasks
Offsite tasks involve site preparation and design, but also 
system monitoring and maintenance without requiring 
someone present at the site.

Operations
A completed Project template (intake form) is the basis 
to create tickets. Tickets are required for creating a new 
customer and/or a new site, and creating, submitting, and 
enabling new licenses. These tickets will be handled by 
Global Software Operations (GSO). 

When finished, a request to the Signify Customer Remote 
Operating Center (C-ROC) is necessary to onboard the 
new site. C-ROC then creates work orders for design 
and installation and assigns these to the designer(s) 
named in the Project template. After activation of a site, 
the C-ROC remains involved to monitor the systems and 
provides assistance in case of any issues.

Offsite tasks Onsite tasks
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Lighting designer
The lighting designer uses the site layout/floor plan 
to create a lighting design, resulting in a reflected 
ceiling plan and luminaire count (bill of material for the 
luminaires).

Controls designer
The lighting design needs to be translated into a controls 
design. The controls designer combines the information 
provided in the project template and the reflected 
ceiling plan using System Builder or System Designer. The 
output of the design is a bill of material for the controls, 
a project file, and an installation summary for upload into 
the Interact cloud.

	 Note
A technician license of System Builder is required 
before you can use System Designer.

After the upload is complete, the controls designer uses 
the Interact Multisite System Manager to create and/or 
extend areas, channels, and scenes for the customer.

3.2.2	 Users handling onsite tasks
Onsite tasks like installation and commissioning typically 
require to have someone present at the site.

Installer/site engineer
The designs require approval by the customer, after 
which the products will be ordered and delivered. When 
the site is ready for installation, the installer and/or the 
site engineer can start their activities.

	 3.2	 Users and user roles
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Uses dedicated work orders in the Site Enabler app to:
•	 check and establish IT/cloud connection,
•	 install the Site Gateway and assign it to the cloud by 

scanning the QR-code on the device,
•	 install and wire the Dynalite network controllers 

including the sensors and control panels,
•	 take care to setup the lighting system,
•	 deploy the project file into the onsite installation,
•	 perform a visual inspection using the app to validate 

all areas and channels,
•	 deploy the default concept and schedules from the 

cloud and validate them,
•	 resolve the work order, indicating the site is finalized; 

the user pages should show “Ready to use” for the 
site.

	 3.2	 Users and user roles
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3.2.3	 Users at the end customer

Facility manager
The main task of the facility manager is to ensure 
proper management and maintenance of the sites he is 
responsible for. This includes coordinating maintenance 
and adjustments to onsite equipment, infrastructure, and 
installations.

The facility manager uses Interact Multisite System 
Manager to: 
•	 Scene & schedule management

•	 Viewing of current status only
•	 Emergency cases
•	 Etcetera 

•	 Energy monitoring
•	 Notional energy
•	 Metered energy

•	 Lighting management
•	 Centralized name conventions
•	 Etcetera

Format manager
The responsibility of the format manager is to update 
current brand formats, develop and implement new 
formats and concepts, including design and layout.  

The formula manager uses Interact Multisite System 
Manager to: 
•	 Scene & schedule management

•	 Remote adjustments
•	 Deployment of concept
•	 Access to (groups of) stores in the format 
•	 Etcetera

Store manager
The store manager is responsible for the day-to-
day operation of the store, including inventories 
and personnel, but also to maximize the customer 
engagement and improving sales.

The store manager has access to: 
•	 Local temporary manual override via wall button 

switch or wall panel

	 3.2	 Users and user roles
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Store staff
Store staff includes cashiers, stocking personnel 
etcetera, using local temporary manual override when 
required.

3.2.4	 Maintenance and Service providers
Maintenance and Service providers can provide remote 
services to the retailer. 

Third party personnel with the correct licenses and 
entitlements can login to the dashboard and execute 
facility and format manager roles. The Signify C-ROC 
is also fully capable of providing these services against 
additional cost.

	 3.2	 Users and user roles
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3.3	 Project template and tickets

3.3.1	 Project template
All customer information as described in the previous 
sections is collected in the Project Template (also known 
as Intake Form, see the IA-Retail Project Template). 
Each section corresponds with a step in the offsite 
preparation of the project execution.

The Information concerning the customer, services, 
site, project, and end users needs to be submitted in 
tickets. The Signify Customer Remote Operating Center 
(C-ROC) uses the tickets to enable the site in the cloud. 
A complete process requires tickets in the following 
systems:
•	 C4CS
•	 OTRS

The information in the project template regarding the 
lighting control zones, lighting plan and other control 
options is used to prepare the project for commissioning. 
See the sections 4.3 Prepare the dashboard in the cloud 
and 4.4 Prepare the System Builder job file.
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3.3.2	 C4CS tickets
The C4CS tickets are required to onboard the site to 
C-ROC:
•	 Create a contract in SAP on the account of the 

customer.
•	 In C4CS, create an Installed base ID number using the 

address of the site

	 Note
The SAP contract number and the Installed base 
ID number are required for C-ROC onboarding and 
OTRS tickets.
•	 In C4CS, create a ticket for C-ROC to onboard 

the site. This ticket includes the monthly Energy 
report and Remote monitoring service.

•	 On customer request, create a C4CS ticket to 
enable the optional Remote operating service. 
C-ROC provides this service to the customer. 

	 Tip
Create a BSR-ticket (Business Support Request) in 
C4CS upfront to ensure remote support by a system 
expert.

	 3.3	 Project template and tickets
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3.3.3	 OTSR tickets
Via OTRS you can create all required software 12nc’s 
and onboard all new sites. The tickets to create in OTRS 
include: 
•	 new customer (not applicable for an existing 

customer)
•	 new site 
•	 new license (also covers license extensions) 

•	 IAR multisite standard license
•	 IAR connectivity license (EU/US; for usage of a 

4G-router to enable connectivity to the cloud)

	 Note
For this ticket, a SAP contract number and Installed 
base ID number are required
•	 new user 

•	 At project start, request only the designer 
and site engineer 

•	 At handover, also request the users facility 
manager and format manager

•	 new work order
•	 Design
•	 Onsite commissioning

•	 change request 

	 Note
The user account must be registered in Microsoft 
Azure Active Directory.

	 3.3	 Project template and tickets
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Figure 3. High level overview of project execution
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3.4	 Design, installation, and commissioning process

We prepare the digital twin of the lighting system 
upfront, simplifying the on-site commissioning effort 
so it can be done by your installer or a site engineer. We 
provide the installer with an easy-to-use app that guides 
him step by step through commissioning and validation.
 
3.4.1	 Off-site and on-site activities
The offsite and onsite activities follow a specific 
workflow. Some characteristics in this workflow are:
•	 Work orders arrange a secure and well-defined 

access control; only users with sufficient access 
rights can access the files for the site.

•	 Centralized digital storage ensures a more efficient 
workflow, mitigates errors and double work.

•	 Offsite preparation for a flexible and cost saving 
implementation; expert knowledge onsite is not 
necessary.

•	 The workflow wizard follows a clear workflow with 
well-defined handshakes.

Offsite preparation

Trained experts carry out the off-site preparation that 
consists of the following steps:
•	 Kick-off

•	 Complete project template and requirements 
document based on customer input and alignment,

•	 Request work orders to assign designer(s) and 
installer(s) to the project.

•	 Detailed lighting design
•	 Creation of the reflected ceiling plan.

•	 Detailed controls design
•	 Creation of the project file and upload to the 

cloud.
•	 Preparation of the dashboard in the cloud for the 

customer.
•	 Ordering

•	 Order products (lighting and controls).
 

Offsite preparation KickoffOnsite installation System design Order
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Onsite installation

The installer takes care of the on-site installation that 
consists of the following steps:
•	 Installation

•	 Work order manages access to the site
•	 All lights and controls installed
•	 Establish connectivity of the Site Gateway

•	 Commissioning
•	 Download of the project file and prepare the  

Site Gateway
•	 Cloud provisioning of the gateway
•	 Finalize and deploy project configuration

•	 Validation
•	 End-to-end validation from cloud to light
•	 Final project file updated in the cloud

•	 Site delivery
•	 Work order is resolved, site is “Ready to use”
•	 Handover of the site to the customer

3.4.2	 System Builder/System Designer
For the controls design, the experts use System Builder. 
A technician license of System Builder is required to 
enable System Designer. This is a powerful tool that 
provides a quick and orderly process for designing a 
Dynalite lighting control system.

Onsite, System Builder is used to deploy the prepared 
project file into the Dynet network.

3.4.3	 Philips Dynalite Site Enabler app
With the Philips Dynalite Site Enabler app installed on a 
mobile phone, the installer follows a step-by-step wizard 
using work orders to activate the gateway, validate the 
system and resolving the work orders to enable the site 
“Ready to use”.

Install Commission Validate Deliver

	 3.4	 Design, installation, and commissioning process
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4.1	 Onboarding

A series of tickets need to be handled by Global 
Software Operations (GSO) and the Customer Remote 
Operations Center (C-ROC) to onboard a new site. 
Onboarding needs te be finished before requesting 
licenses and creating work orders.

4.1.1	 Request system activation

•	 The market initiates system activation by generating 
and submitting a license request ticket.

•	 Licenses handle access to specific parts of the 
system related to dedicated roles, in some cases in 
combination with work orders.

•	 Work orders are used to assign specific tasks (design, 
installation, and commissioning) to dedicated roles.

4.1.2	 Assignment of roles
The project template can be used to specify the people 
and their contact details to a specific role. There are 
roles defined that are applicable for Signify and partner 
personnel as well as roles for the customer and/or 
service provider:

Signify and partner roles:
•	 Main contractor
•	 Lighting designer
•	 Controls/site designer
•	 Installer/site designer

Customer and service provider roles:
•	 Facility manager
•	 Format manager for each specific format
•	 Third party service provider
 

Submit Validate and issue Enable
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	 Note
For training and demonstration purposes, it’s advised 
to grant Signify representatives both facility and 
format manager roles.

See Appendix B Roles and responsibilities for more 
information.

Assignment of roles is to be requested at Customer 
Remote Operating Center (C-ROC).

4.2	 System design

The system design of the Multisite system is different 
when compared to a standard Dynalite system. Multisite 
is a simplified, easy to use system, providing full control 
to the customer. The system requires a design-in for the 
complete customer offer (luminaires + controls). Both 
lighting and controls design require a work order to be 
assigned to the person having the dedicated role that will 
carry out the task.

4.2.1	 System characteristics
During design and commissioning of an Multisite system, 
pay attention to the following system characteristics:
1.	 The Multisite system combines a modular Dynalite 

control topology with a user interface developed 
for a retail store. Currently, multiple types of control 
components in the system are supported:
•	 DALI individual addressable luminaire controllers
•	 DALI broadcast controllers
•	 Phase cut dimmable controllers
•	 Pulse Width Modulation (PWM) controllers
•	 Relay controllers
•	 0-10 V/1-10 V/DSI controllers
•	 Dry contacts
•	 Sensors and user interfaces
•	 For load controllers tested and verified for the 

Store system, see section 4.2.3 Controls design  
for the types.

2.	 A System Builder (SB) job file including a basic 
configuration is available for faster creation of a 
project specific job file.

Lighting design Control design
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3.	 Pre-design of the project area configuration is crucial 
since the area allocation can only be achieved by 
separating the physical channels by means of wiring. 
The physical channels are mapped to the logical 
channels which can easily be renamed to the specific 
needs for these areas. For instance, Fresh food, 
Bakery, etc. These names are shown in the UI.

4.2.2	 Lighting design
The specific requirements of the customer and the 
specifics of the site layout are considered when creating 
the lighting design, that results in the reflected ceiling 
plan and a luminaire count (lighting bill of materials). 

Capturing the lighting design graphically in a (AutoCAD) 
drawing influences the speed and accuracy of the 
controls design.

Details of the lighting design can be provided in the 
project template.

4.2.3	 Controls design
While using System Designer, it generates:
•	 Bill of Materials (BoM)
•	 Project file (stored in the cloud)
•	 Installation summary
•	 Wire diagram
•	 Load schedule report

Limitations
The Site Gateway requires a fully available and 
functioning internet connection at the day of installation. 
This connection must be secure and available 24/7. Also, 
a firewall preventing inbound communication is of the 
highest importance.

See the FLX Multisite Security Statement for further 
details of required ports to be opened, protocols 
that need to be enabled, etcetera. This document can 
be found on the Signify Partner Portal and should be 
discussed upfront with the IT representative of the 
customer.
 

	 4.2	 System design
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	 Note
Each site equipped with Multisite generates an 
expected average traffic of 1 GB/month.

Quantity of network devices
Theoretically, the RS-485 standard allows to connect an 
unlimited number of devices to a data cable. Practically, 
it’s recommended to limit the number of devices per 
gateway (spur) to 100.

In case the system requires higher numbers of devices 
on the gateway, this is possible. For more information, 
see the generic System Builder documentation.

Power supply
Because several devices are powered over the network, 
the quantity of consuming devices such as panels and 
sensors need to be considered. Typically, most panels 
and sensors will run between 10 to 15 Vdc at 25 mA.

To overcome a voltage drop, or in case of a large number 
of consuming devices, a secondary power supply 
(DDNP1501) can be added to boost the overall network 
voltage. The DDNP1501 can supply 15 Vdc at 1 .5 A.
 
In general, most Philips Dynalite load controllers 
generate approximately 100 mA to the DyNet network 
and will drive 4 or 5 consuming devices without the need 
for a secondary power supply. Refer to the product data 
sheets for calculation the power requirement for the 
Dynet communication bus.

Make sure to use DyNet-STP-CABLE-LSZH  
(or equivalent) cables.

	 4.2	 System design
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Wired controllers
The specifications of each controller type limit the 
number of luminaires that can be connected. Refer to 
the product data sheets for detailed information. The 
given limitations:

DDBC1200
•	 12 control outputs, selectable to DALI, 0-10 V/1-10 V 

or DSI output capacity.
	 In DALI Broadcast mode: 80 DALI drivers per channel, 

300 total.

DDBC120-DALI
•	 Single DALI control output, supporting one full DALI 

universe of 64 addresses.
•	 One feed-through relay rated at 20 A (500 A surge) 

for switching power to the drivers.

DDBC300-D
•	 Three DALI outputs, allowing to control up to 192  

DALI devices.

 

DDBC320-D
•	 Three DALI outputs, allowing to control up to 192  

DALI devices.
•	 Three feed-through switched circuits rated at 20 A 

for DALI driver mains supply.

DDRC420FR
•	 Four switched feed-through outputs at 20 A 

(inductive), maximum device load 80 A
•	 Rated inrush current: 500 A

DDRC1220FR-GL
•	 12 switched feed-through outputs at 20 A (inductive), 

maximum device load 180 A
•	 Rated inrush current: 500 A

	 4.2	 System design
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4.2.4	 System wiring

Cable limits

DyNet cable length
•	 When using the DyNet STP Cat 5 cable, the number of 

Philips Dynalite devices is limited to 100.
•	 The maximum Cat5 cable length between the devices 

is 100 m.
•	 Any other cable used for RS-485 data transmission 

should be of the type STP with a characteristic 
impedance the twisted pair between 100 to 120 Ω.

•	 The maximum current a single spur can draw is limited 
to 2 A.

DALI cable cross sections
The maximum voltage drop on the DALI bus is 2 V. 
Therefore, use cables with the specifications according 
to the table. DALI cables of over 300 m (1000 ft) are not 
allowed.

DALI conductor diameter

Length Cross section

≤ 100 m ≤ 330 ft 0.5 mm2 AWG 20

100 to 150 m 330 - 500 ft 0.75 mm2 AWG 18

150 to 300 m 500 - 1000 ft 1.5 mm2 AWG 16

	 4.2	 System design
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Ethernet cable length
The length of the Ethernet cables is limited to 100 meter 
per run.

Built-in dry contacts
The maximum distance to the input source depends on 
the type of connection and the device used to create 
the connection. See the specification sheets of the 
specific components for more details with regard to 
maximum cable lengths etcetera.

Physical connection testing
The Store controllers have manual override buttons, 
which will help the site engineer to confirm the correct 
physical power connection. Control protocol tests can 
only be performed with System Builder as a tool, or on 
the mobile device, by moving the sliders in the Scenes 
page for each channel. Refer to the respective product 
installation guides for correct test procedures.

	 4.2	 System design
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4.3	 Prepare the dashboard in the cloud

Before you start preparations in the cloud:
1.	 Open an appropriate web browser, see section  

2.2.2 Requirements for the dashboard.
2.	 In the web browser settings, change the cookies 

setting to Allow all cookies.

	 Note
The image shows the setting on Google Chrome. 
The procedure to change this setting differs per 
browser.

3.	 Browse to the web page with the address:
www.eu.retail.interact-lighting.com

4.	 Click Login and follow the steps to login to the 
dashboard.

	 Note
In this guide, we use the demonstration project as an 
example. Where the desired configuration can differ, 
the steps to follow are identical.

http://www.eu.retail.interact-lighting.com
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	 Important
Be aware of possible impact when adding or editing 
parent areas, scenes, child areas and logical 
channels. Therefore, this should be done with 
caution. Selecting None or a Format results in:
•	 None: create a general set of parent areas and 

scenes, and child areas and logical channels that 
can be assigned to specific formats afterwards. 
See section 3.1 Formats.

•	 Format: create parent areas and scenes, and 
child areas and logical channels directly for the 
selected format. These settings can be assigned 
to other formats afterwards too.

4.3.1	 Add parent area
1.	 In the menu, click Configuration.
2.	 Select Areas & scenes.
3.	 Select None or a Format.
4.	 Click Create new area.

1

2
3

4
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5.	 Enter the ID number for the area.

	 Important
•	 It’s advised to use consecutive IDs consistent on 

newly created parent areas, starting from area  
ID 2.

•	 Make sure to use identical ID numbers and names 
for the parent areas in both the cloud and System 
Builder.

6.	 Enter the Name of the area.
7.	 Optionally, select the checkbox Day & Night Mode to 

enable this option.
8.	 Click Save.

	 Note
•	 Enabling the day and night mode activates 

automatic switching of the area by the system 
based on sunrise and sunset.

•	 Areas with the day and night mode enabled can be 
identified by the  icon.

9.	 Add all required parent areas by repeating the steps 
above.

5
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4.3.2	 Add scene
1.	 In the menu, click Configuration.
2.	 Select Areas & scenes.
3.	 Select None or a Format.
4.	 With the mouse, in the Scenes column next to the 

area to add the scene to, hover over the action menu 
icon ( ).

5.	 Click Create new scene.

45
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6.	 Enter the ID number for the scene.

	 Important
•	 It’s advised to use consecutive IDs consistent on 

newly created scenes, starting from ID 1.
•	 Make sure to use identical ID numbers and scene 

names for the presets in both the cloud and 
System Builder.

•	 Per parent area, the IDs of the scenes may 
restart.

7.	 Enter the Name of the scene.
8.	 Click Save.
9.	 Add all required scenes for each area by repeating 

the steps above.

6
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4.3.3	 Add child area
1.	 In the menu, click Configuration.
2.	 Select Areas & scenes.
3.	 Select None or a Format.
4.	 Click an Area to show the list of child areas.
5.	 Click Create new child area.

4

5
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6.	 Enter the ID number for the child area.

	 Important
•	 It’s advised to use consecutive IDs consistent on 

newly created child areas.
•	 It’s suggested to assign the child area ID taking 

the ID of the parent area as a base. For example: 
the first child area of the area with ID 2 will get 21 
as ID.

•	 Make sure to use identical ID numbers and names 
for the child areas in both the cloud and System 
Builder.

7.	 Enter the Name of the child area.
8.	 Click Save.
9.	 Add all required child areas by repeating the steps 

above.
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4.3.4	 Add logical channel
1.	 In the menu, click Configuration.
2.	 Select Areas & scenes.
3.	 Select None or a Format.
4.	 Click an area to show the list of child areas.
5.	 With the mouse, in the Logical channels column next 

to the child area to add the channel to, hover over 
the action menu icon ( ).

6.	 Click Create new logical channel.

6
5
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7.	 In the dropdown menu, select the type of logical 
channel, set by default to Dimming/Switching.

	 Note
Select the type RGB when the use of the channel is 
intended for, for example, colored accent lighting.

8.	 Enter the ID number for the channel.

	 Important
•	 It’s advised to use consecutive IDs consistent on 

newly created logical channels, starting from ID 1.
•	 Make sure to use identical ID numbers and names 

for the logical channels in both the cloud and 
System Builder.

•	 Per child area, the IDs of the logical channels may 
restart.

9.	 Enter the Name of the channel.
10.	Click Save.
11.	 Add all required logical channels for each child area 

by repeating the steps above.
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4.3.5	 Edit usage of areas, scenes and channels
There are multiple ways to edit the usage of areas, 
scenes, and channels for the available formats.

Edit usage for all formats
1.	 Select the format None (no format).
2.	 Click:

•	 Areas & scenes
•	 An Area to optionally click an area to show the list 

of child areas and logical channels. 
3.	 Hover over the action menu icon ( ) and select 

Usage.
4.	 Select the usage in the popup. 

Select usage for a specific format
1.	 Select the format None (no format).
2.	 Click:

•	 Areas & scenes
•	 An Area to optionally click an area to show the list 

of child areas and logical channels.
3.	 Click  Edit usage. Select the check box to enable 

(child) areas and select the scenes or logical channels 
to enable them.

4.	 Click Save. 

	 4.3	 Prepare the dashboard in the cloud
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4.3.6	 Add concept
Each format requires a concept. The Site Enabler app 
deploys the concept during commissioning of the site.

	 Important
Make sure to create a concept with realistic light 
levels, preferably according to the wishes of the 
customer.

Create concept
1.	 In the menu, click Light control.
2.	 If applicable, in the dropdown Select a customer, 

select the customer. 
3.	 Select a format.
4.	 Click Concepts (  ).
5.	 Click + New concept.
6.	 Give the concept a name and click Create.

1
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Edit concept

	 Note
•	 You can only edit concepts with the status Draft.
•	 The scene that you edit shows dark. Select 

another scene to start editing the settings of this 
scene.

1.	 Click on the name of the concept you just created.
2.	 Click on the row of an area to start editing.
3.	 Start editing the light settings for the area:

a.	 Select a scene to edit its light settings 
b.	 Switch the zone ON or OFF.
c.	 Move the dim slider to adjust the light level;
	 or: Enter the value in the box.
d.	  Use the Master slider to change the relative dim 

level of all zones that are switched to ON.
4.	 Click Save changes.
5.	 Repeat for the other scenes in the area.
6.	 Repeat for the other areas.

	 Tip
See the User guide for more information about 
editing concepts.
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4.3.7	 Add schedule
Each format requires a schedule. The Site Enabler app 
deploys the schedule during commissioning of the site.

	 Important
Make sure to create a schedule with a realistic 
timeline, preferably according to the wishes of the 
customer.

Create new schedule
1.	 In the menu, click Light control.
2.	 If applicable, in the dropdown Select a customer, 

select the customer.
3.	 Select a format.
4.	 Click Schedules ( ).
5.	 Click + Add Multisite schedule.
6.	 Give the schedule a name and click Save.
7.	 Click + Add to start creating the schedule.
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Add the schedule
When creating and editing schedules, keep in mind that 
the wizard follows a structured order:
•	 When: start/end date, weekdays, and months
•	 Where: area(s) the schedule applies to
•	 What: what happens on the defined times

1.	 On the When page, make the below calendar 
selections:
a.	 Select the Type of event.
b.	 Click the calendar ( ) to select the Start date.
c.	 Click the calendar ( ) to select the End date 

(optionally).
d.	 Clear/select the days for the Weekly Pattern.
e.	 Clear/select the months for the Monthly Pattern.
f.	 Click Next.

	 Note
When creating a Special event, specify an End date in 
the far future. Select a date using the calendar and 
change the year manually to, for example, 2099.

2.	 On the Where page, select the Areas the schedule 
applies to and click Next.
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3.	 On the What page, make the timer selections:
a.	 Enter the Name for the schedule.
b.	 Select the Unknown schedule and select the 

Scene and Fade.
c.	 Click the clock ( ) to define the Start time for 

the next timeframe.
d.	 Click Add Action.
e.	 Select the Scene and Fade.

4.	 Repeat for other timeframes. Make sure to select the 
Scene and Fade for all timeframes on the timeline. 
Click Next.

	 Important
Always make sure that the timeline covers 24 hours. 
A timeframe labeled Unknown is not allowed.

5.	 Check the settings. Click Previous to make changes 
to the schedule.

	 Or: Click Add to close the wizard and add the 
schedule to the list.

	 Tip
See the User guide for more information about 
editing schedules.
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4.3.8	 Prepare energy metering in the cloud

	 Note
Preparation of energy metering is only required 
when smart meters are used to measure energy 
consumption. Otherwise, this step can be skipped.

1.	 Browse to the Interact Multisite System Manager 
pages and in the menu, click Configuration.

2.	 Select  Smart meter groups.
3.	 Click Create metered group.
4.	 Enter a Group name for the metered group and 

provide a Group description. 
5.	 Click the dropdown and select Select All. Click Save.

	 Note
Currently it’s not possible to limit the selection to a 
few formats only.

6.	 Add all required metered groups (power zones) by 
repeating the steps above.

	 4.3	 Prepare the dashboard in the cloud
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4.4	 Prepare the System Builder job file

4.4.1	 How to design the system
In general, there are the following methods to design  
the system:
•	 Using classic System Builder
•	 Using the System Designer feature in System Builder

Benefits of using System Designer compared to classic 
System Builder:
•	 System Designer calculates the lengths of the DALI 

cables and shows a message if the cable is too long.
•	 System Designer keeps track of the load of the DyNet 

devices and shows a message if the load is too high, 
requiring an additional power supply.

•	 System Designer produces reports that summarize 
the total number and types of luminaires, controllers, 
and other devices, as well as the total cable length. 
This helps when creating a quote.

 

	 Important
Make sure to always align the names and IDs for the 
areas, child areas, logical channels, and scenes, as 
created in section 4.3	Prepare the dashboard in the 
cloud. 

	 Note
You need a technician license before you can use the 
System Designer feature in System Builder. You need 
to raise a ticket to request such license; see section 
6.1.2 Ticketing system (C4CS) how to do that.

	 Tip
Find more information about using System Designer 
can be found in the User Guide. Click Help > User 
Guides and select the System Designer User Guide.

In this section we describe the steps to take using the 
System Designer feature when creating the offsite 
design of the system.
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4.4.2	 Using System Designer
•	 After the technician license is enabled, click the 

button Design Mode ( ) to start the System 
Designer feature.

•	 Use the buttons in the Window menu to switch 
between the  Properties Window and the 

  	  Floor Plan Window.
•	 When following the steps of the Design Assistant, 

take care for the attention points below:
1.	 5. Define Scale: Use Enter Background Scale when 

you know the scale of the floor plan used. 
	 Use Draw Background Scale to define the scale 

manually. You can do this for example by measuring 
the distance between doorposts or the bay width 
of the shelves.

2.	 7. Add Distribution Boards: Consider the expected 
cable lengths when finding a good position for the 
distribution board(s) on the floor plan.

3.	 10. Group Fixtures: Use Draw DALI Cable to 
connect the DALI controlled luminaires, both 
broadcast and addressable.

	 Use Draw Fixture Group for switchable luminaires.

	 4.4	 Prepare the System Builder job file
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	 Note
•	 Make sure not to exceed the maximum number of 

devices on a DALI universe.
•	 Make sure to add luminaires to the correct 

universe, either broadcast or addressable.

4.	 10. Group Fixtures: After drawing the DALI 
universes, a symbol ( ) shows that the DALI cable 
is not connected to a distribution board (or a 
controller). 

	 Click Draw Line ( ) and select Draw DALI Cable to 
connect the universe to a distribution board (or a 
controller).

5.	 12. Draw Areas: Only draw areas that were defined 
as Child areas (for example: cash registers, main 
sales floor, etcetera). The main areas are created 
later.

	 Important
Make sure to use identical ID numbers and names for 
the child areas in both the cloud and System Builder. 
See section 4.3.3 Add child area.

	 4.4	 Prepare the System Builder job file
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6.	 13. Draw DyNet Cable: When drawing DyNet 
cables, also make sure to connect the cable to 
a distribution board. If controllers are added to 
the distribution board in step 15, the symbol ( ) 
disappears.

7.	 15. Select Hardware: Click Open Hardware 
Selector Window and in the left panel select a 

 Circuit or  Universe (added in step 7). 
	 Select the controller of choice to add to the 

distribution board. 

	 Note
The selection of controllers depends on the type 
of universe. Universes spanning multiple areas must 
be assigned to a DALI addressable controller. For 
more information, see section 5.3.2 Configure DALI 
individual addressing.

	 4.4	 Prepare the System Builder job file



63	 Chapter contents

04	 Offsite preparation

	 Main contents

8.	 15. Select Hardware: In the left panel, select a 
Circuit or DALI universe and assign it by drag and 
drop to the appropriate controller in the right 
panel. 

9.	 15. Select Hardware: In the left panel, select all 
added devices (load controllers, sensors, user 
interfaces) one by one and click  Rename to 
give each device a unique name.

	 Important
Give each device (controller, sensor, user interface) 
a unique name, for example by adding a consecutive 
letter or number, or any other identification (for 
example: usage or location). The reports reflect the 
names to help you identify which physical channel is 
connected to which controller. 

10.	15. Select Hardware: Click Apply To Job. Click 
Yes to confirm. A message shows if any problem 
occurs.
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Close System Designer
Before closing System Designer:
•	 Make sure the Fixtures Grouped indicator shows 

100%.
•	 Make sure there are no exclamation marks ( / ) 

showing.
•	 Follow the steps 16. Generate Reports and  

17. Produce Documentation.
•	 Click the button Design Mode ( ) to close the  

System Designer feature.
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Figure 4. Possible result after using System Designer
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4.4.3	 Finalize logical hierarchy

Create parent areas
1.	 In the Areas view, click  Insert New Area.
2.	 Create the Parent Areas according to the  

Project Template. 

	 Important
Make sure to use identical ID numbers and names 
for the parent areas in both the cloud and System 
Builder. See section 4.3.1 Add parent area.
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Create logical channels (DALI enumerated)
Prepare the logical channels for use with DALI 
enumerated universes. You need these logical channels in 
the Onsite commissioning.

	 Note
Create the logical channels in the corresponding 
child areas according to the Project Template.

1.	 In the Areas view, select the desired Child area, for 
example Cash Registers. 

2.	 Click  Insert New Channel to create a new logical 
channel.

3.	 Create the logical channels according to the project 
template.

	 Important
Make sure to use identical ID numbers and names for 
the logical channels in both the cloud and System 
Builder. See section 4.3.4 Add logical channel.

4.	 Repeat for all logical channels in child areas using  
DALI enumerated.
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Rename logical channels (DALI broadcast and Relay)
In the Hardware Selector, you assigned logical channels 
to a physical channel on the broadcast and relay 
controllers.

1.	 On the View menu, click Areas View.
2.	 In the Areas view, select a child area that is assigned 

to a DALI broadcast ( ) or Relay ( ) controller.
3.	 Right-click on the logical channel and select  

 Rename.

	 Important
Make sure to use identical ID numbers and names for 
the logical channels in both the cloud and System 
Builder. See section 4.3.4 Add logical channel.

4.	 Repeat for all other logical channels that are assigned 
to a DALI broadcast or Relay controller.
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Assign child areas to corresponding parent area

	 Note
•	 In the offsite preparation, it’s only possible to set 

Base Link Areas (BLA) and Loads for channels of 
broadcast and relay controllers. 

•	 Configuration of enumerated channels is part of 
Onsite commissioning. See section 5.3.2 Configure 
DALI individual addressing. 

•	 The ID of the Base Link Area is the same as the ID of 
the parent area to which the child area belongs.

1.	 In the System view, open the tree of the Load 
Controllers and select a controller.

2.	 On the Outputs tab, in the column Base Link Area, enter 
the number of the parent area the Physical Channel links 
to.

	 Note
You can also draw the Base Link Areas in the Floor Plan 
View. Click  next to  (Draw Area Region) and select 

 Draw Base Area Region.

3.	 Fill in the Load in Watts and set the Power Category of 
the physical channel to Lighting.
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Add status and notes to areas
In System Builder, you can set the status of areas and 
also leave notes. This additional information is stored 
in the job file and can help the engineer onsite with 
commissioning of the site. 

1.	 Right-click on the name of a child area and select  
 Set Status. Select the status of choice (for 

example Attention Required to add an area note).
2.	 You can also right-click on the name of a child area 

and select  Add Area Note.

	 Tip
With an area note, you can explain that a child area 
(Cash Registers) belongs to a specific parent area 
(Sales Floor) and give a summary of some details 
(contains two logical channels, DALI enumerated) for 
the onsite commissioning.
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Add the Site Gateway
1.	 In the System view, click  Insert Device from List.
2.	 Select the Network Devices tab. 
3.	 Under Gateways - Ethernet, double-click the 

PDDEG-S. 
4.	 The PDDEG-S is added to the topology.

	 Important
The power supply to the PDDEG-S Ethernet Gateway 
must be continuously available. It’s not allowed to 
switch off the device during the night.

Create topology
1.	 Press Shift to multiselect the Load Controllers, and if 

applicable also the User Interfaces and Sensors.
2.	 Move the devices under the PDDEG-S. Click Yes to 

confirm.
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4.4.4	 Configure Site Gateway 

Configure schedules
A total of 100 empty and disabled schedules must be 
available.
1.	 In the System view, select the PDDEG-S.
2.	 On the Schedules tab, check if there are 100 

Undefined Schedules available. Make sure that all 
schedules are disabled. 

	 Note
Clear the checkbox Enabled to disable the 
schedules. Make sure that for all schedules, the 
Schedule Type is set to Simple Event. Especially 
check from schedule 41 and higher.

	 Tip
It’s possible to add up to 100 schedules. Reaching 
that number inactivates the button New Schedule.
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Configure public holidays
A total of 30 disabled public holidays needs to be 
created.
1.	 On the Schedules tab, click Set Public Holidays.  

Click Add.
2.	 Select the created New Public Holiday and clear the 

Enabled checkbox.
3.	 Repeat the steps for all 30 public holidays. 
	 Click OK.

	 Tip
It’s possible to add up to 30 public holidays. Reaching 
that number inactivates the button Add.

	 4.4	 Prepare the System Builder job file



74	 Chapter contents

04	 Offsite preparation

	 Main contents

Configure special events
A total of 30 disabled special events needs to be 
created.
1.	 On the Schedules tab, click Set Special Events. 
	 Click Add.
2.	 Select the created New Special Event and clear the 

Enabled checkbox.
3.	 Repeat the steps for all 30 special events. 
	 Click OK.

	 Tip
It’s possible to add up to 30 special events. Reaching 
that number inactivates the button Add.
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Set location and time zone
1.	 On the Schedules tab, click Set Location And Time 

Zone.
2.	 In Country, select the country where the site is 

located.
3.	 In City, select a city reflecting the correct time zone 

for the site.
4.	 Click OK.

	 Note
In most cases, selecting the country and city is 
sufficient to reflect the correct time zone. If no 
proper location is available from the list, select 
Custom from the country list and enter the DMS 
Latitude and DMS Longitude.
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Check and edit Gateway settings
1.	 In the System view, select the PDDEG-S.  

Click  Advanced.
2.	 On the Device Properties tab, check the settings:

a.	 In the section Ethernet Applications:
•	 Authentication required for: CGI Only
•	 Batch Reporting: Enabled

b.	 In the section Scheduler:
•	 Reserved event schedule records: 100
•	 All Reserved […] schedule name (bytes): 32
•	 Reserved special event and public holiday 

records: 30
3.	 On the Ports tab, in the section IPv6, set the 

following:
•	 Send on default multicast service: Disabled
•	 UDP default multicast port: Disabled
•	 UDP default unicast port: Disabled

4.	 On the Routing tab, clear the Route RS485 and 
Default Multicast Service checkbox.

5.	 Make sure the leave the default settings of the Web 
Socket Port and Routing.

6.	 On the Users tab, in the section User properties, 
leave the defaults for the admin user as is.

2
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4.4.5	 Integration of manual override, BMS and alarm

Configure manual override with Antumbra

	 Note
This configuration is optional, depending on the 
requirements of the customer or project.

Because the system should run on automatic mode most 
of the time, the duration of a manual override is limited to 
maximum two hours. To achieve this, a task needs to be 
enabled.

1.	 Login to the Signify Partner Portal and select 
Technical documents.

2.	 Select Signify Only > Retail > Interact Retail >  
IAR Multisite > Commissioning. 

3.	 Right-click the file Interact Retail Multisite_Manual 
2-Hour Override&Alarm-BMS Integration_v1_03.evt 
and click Save link as.

	 Tip
The file extension probably changes to .txt. It’s not 
necessary to change this back to .evt.

3
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4.	 In the System view, select the PDDEG-S.
5.	 On the Tasks tab, click  Select Task Template.
6.	 Click Import and find the file in the file system.  

Select the file and click Open.

	 Tip
If necessary, change the filter from Evt Files (*.evt) 
to All Files (*.*).

7.	 Select the imported file and click OK.
8.	 Select the number of Base Link Areas (BLAs).
9.	 Find the Base Link Area #1, for Enabled select True 

and select the Area that corresponds with the 
created Base Link Area.

10.	Repeat for the other Base Link Areas.

	 Note
•	 It’s possible to define up to three Base Link Areas 

for manual override functionality. Contact your 
Signify representative in case more BLAs are 
necessary.

•	 The 2-hour timer feature for the manual override 
requires additional configuration of a join byte. 
See section 4.4.9 Configure user interfaces for 
more information.

6
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Configure manual override with touch screen
It’s possible to configure existing Store/StoreWise 
installs equipped with a DTP100/PDTS touchscreen to 
Multisite. See Appendix D Upgrade of a Store system with 
touch screen.
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Configure Alarm/BMS system
The task template Interact Retail Multisite_Manual 
2-Hour Override&Alarm-BMS Integration_v1_03.evt 
allows to integrate an alarm with Multisite. When arming 
the alarm, all running schedules will be overridden until 
the alarm is physically stopped.

	 Note
The alarm integration task is loaded to the Site 
Gateway. In Store/StoreWise, the alarm is integrated 
with the system via a dry contact. An additional 
link between the dry contact and task on the Site 
Gateway must be established to be able to trigger 
the tasks. See section 5.3.5 Configure Dry contact 
connections for more information.
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Add gateway to the Building view (floor plan)
1.	 Place the Site Gateway by drag and drop to the 

distribution board on the floor plan.
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4.4.6	 Placeholder presets
Like we did for the parent and child areas, and the logical 
channels, also the scenes as we created in section 
4.3.2 Add scene require an equivalent in the job file we 
are creating in this section. This equivalent is found in 
the placeholder presets. In order for the customer to 
recall and create their own scenes, we need to create 
empty presets that act as placeholder for the scenes we 
prepared in the cloud, but also for future scenes.

Each scene requires a corresponding preset per parent 
area (BLA) and child area. Scenes with Day & Night Mode 
enables require two presets, as these will be presented 
with two sliders in the cloud.

	 Important
Make sure to always align the names and IDs of the 
presets with the scenes as created in section  
4.3.2 Add scene.Figure 5. Difference between scenes with or without  

Day & Night Mode enabled.
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Create presets for parent areas
In the project template, several presets are defined 
and agreed with the customer. To give the customer 
the possibility to create their own presets, you need 
to create more presets than defined in the project 
template.

1.	 In the Areas view, select a parent Area. Select the tab 
Preset Editor.

2.	 On the tab Preset Editor, select  New |  >  
Set Total Presets.

3.	 Enter the total number of 64 presets and click OK.
4.	 Repeat the steps for all parent areas.
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Rename the presets
1.	 In the Areas view, select a parent Area. 
2.	 On the Preset Editor tab, right-click on the preset 

and select  Rename.
3.	 Align the name of the preset with the name of the 

scene with the corresponding ID on the dashboard.

	 Important
Make sure to use identical ID numbers and scene 
names for the presets in both the cloud and System 
Builder. See section 4.3.2 Add scene.

4.	 Repeat the steps for all scenes defined in the project 
template.
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Copy the presets
1.	 In the Areas view, select a parent Area.
2.	 On the Preset Editor tab, select all presets you 

created and click  Copy.
3.	 Select a child area that is linked to the parent area.
4.	 Select all presets and click  Delete Preset.
5.	 Select    > Create New Presets.
6.	 Repeat for all child areas linked to a parent area.

	 Important
Keep in mind to copy the presets from the parent 
area to the corresponding child areas.
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4.4.7	 Configure controllers
The preparation of DALI differs per control method:
•	 DALI Individual Addressing: no preparation done; 

commissioning is part of the onsite activities. See 
section 5.3.2 Configure DALI individual addressing for 
more information.

•	 DALI Broadcast: preparation done with System 
Designer, where the channels are connected to the 
corresponding circuits and distribution board. 

•	 Dry contact interface: can be configured for Manual 
2-hour override, which provides the functionality to 
overrule running scene with a different preset, which 
reverts to the previously scheduled scene after two 
hours. Can also be configured to provide integration 
with alarms systems. Make sure to configure the dry 
contacts according to the wishes of the customer. 

Before configuration, make sure to load the specific task 
to the PDDEG-S Ethernet Gateway. See section  
4.4.5 Integration of manual override, BMS and alarm.
•	 When configuring for Manual 2-hour override, make 

sure to:
a.	 Change the Join byte to 0x83.
b.	 Set the Function to Preset.
c.	 Select the Preset associated with the Dry 

contact.
•	 When configuring for Alarm integration, make sure to:

a.	 Change the Join byte to 0x85.
	 And complete the configuration onsite (see section 

5.3.5 Configure Dry contact connections for more 
information):
b.	 Set the Function to Custom.
c.	 On the PDDEG-S, start task 5 (Alarm armed)
d.	 On the PDDEG-S, start task 4 (Alarm disarmed)
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•	 All controllers (DALI, relay, etcetera) need to have a 
unique name. When the same type of controller exists 
multiple times in the system, make sure to change the 
name of each of the controllers and make it unique, 
for example DDBC1200 #1, DDCBC1200 #2, etcetera. 

	 To rename a device: in the System view, simply right-
click the device and select Rename.

•	 Give the Outputs of the controllers the ID of the 
correct Base Link Area. See section 4.4.3 Finalize 
logical hierarchy.

	 Note
Make sure that that each child area may contain only 
one Master Channel.

4.4.8	 Configure sensors (on-site)
Sensors can add the following functionalities to the 
system:
•	 Daylight sensing: sensor that adapts the lighting in 

the assigned area or for the selected channel based 
on the ingress of daylight. This is called ‘Daylight 
Harvesting’. Most daylight sensors also have the 
possibility for occupancy sensing.

•	 Occupancy sensing: sensor that detects the 
presence of people and switches the lights ON/OFF 
or to the desired pre-configured preset.

Commissioning of sensors follows the standard Dynalite 
rules and is handled in two stages:
•	 Offsite preparation
•	 Onsite commissioning 

	 Note
For onsite commissioning, it’s recommended to have 
Torch sign on feature enabled, and/or IR control.
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Offsite preparion
Following the System Designer step, sensors should be 
located on a floor plan. This means the sensors have 
been selected and assigned to certain areas and have 
been given a unique name in System Builder.

Motion Control - specific configuration
•	 Verify to which area the sensor is configured. 
•	 Specify if the sensor should control a parent area 

(BLA) or a child area.
•	 Configure Join byte to 0x81.
•	 When configuring the sensor to a child area, set 

the link with the correct BLA (tab Motion control > 
Advanced > Logical Address-BLA).

•	 Modify and configure specific sensor settings if 
required.

•	 Create the desired amount of presets and assign 
actions.

•	 Use resend inhibit period to avoid over-flooding the 
DyNet network.

Daylight Harvesting - specific configuration:
•	 Verify to which area the sensor is configured. 
•	 Specify if the sensor should control a parent area 

(BLA) or a child area.
•	 Select type of loop (using closed loop control disable 

open loop control and other way around).
•	 Specify if sensor should control all channels in the 

area or only a specific channel.
•	 Configure Join byte to 0x82.
•	 When configuring the sensor to a child area, set 

the link with the correct BLA (tab Motion control > 
Advanced > Logical Address-BLA).

•	 Modify and configure specific settings for open or 
closed loop regulation, if required.

•	 Create presets (closed loop) or define bands  
(open loop) with agreed settings.

•	 Disable Motion Control if it’s not required.

	 Note 
For onsite commissioning of the sensors, it’s 
recommended to enable the Torch sign on feature, 
and/or use an IR control.
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4.4.9	 Configure user interfaces
User interfaces (UI) are part of the system for manual 
control. The following types of UIs are available:
•	 Antumbra button, touch, and display
•	 Revolution series panels
•	 PDTS touch screen, DTP100 is supported

Commissioning of sensors follows the standard Dynalite 
rules and is handled in two stages:
•	 Offsite preparation
•	 Onsite commissioning

Offsite preparion
Following the System Designer step, UIs should be 
located on a floor plan. This means the UIs have been 
selected and assigned to certain areas and have been 
given a unique name in System Builder.

Antumbra - specific configuration
•	 Make sure to configure all buttons according to 

the wishes of the customer. The buttons can be 
configured to control either parent areas (BLA) or 
child areas.

•	 For each preset button, configure Join byte to 
0x83. This configuration enables the 2-hour manual 
override in case you imported the corresponding 
task.

•	 For the Antumbra Display, it’s possible to add 
additional features, including displaying time, local 
temperature, icons, logos etcetera.
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Touch screen – specific configuration
It’s possible to configure existing Store/StoreWise 
installs equipped with a DTP100/PDTS touchscreen to 
Multisite. See Appendix D Upgrade of a Store system with 
touch screen.
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4.4.10 Check location and time zone of the job file
It’s important to set the correct location and time zone 
of the job file, despite that this procedure has similarities 
with Set location and time zone in section  
4.4.4 Configure Site Gateway which basically does the 
same for the Site Gateway.

	 Important
Make sure to set the location and time zone to the 
actual location, especially when working abroad and 
possibly in a different time zone.

1.	 On the Tools menu, click Set Location and Time Zone.
2.	 Check and if necessary change the Location and Time 

Zone. 
3.	 Make sure to click OK.

	 Important
It’s mandatory to click OK, also if you didn’t change 
the location and time zone settings.
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4.4.11	 Save job file to the cloud
Once the preparation of the job file is finished, it needs 
to be uploaded to the cloud to make it available for 
onsite commissioning.

Login to the cloud
1.	 On the Tools menu, click Online Accounts….
2.	 Click  Add and select Retail Account….
3.	 Select the Region and click OK.
4.	 Select your account to login to. If required, fill in your 

password.

	 Note
•	 Your user account must be registered in 

Microsoft Azure Active Directory before you can 
login to the Retail Account.

•	 The status bar at the bottom shows your 
connection status and the region you’re 
connected to.
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Save job file
1.	 On the File menu, click Save As and select Save Job  

To Cloud.
2.	 Find and select the applicable work order. 
3.	 When the work order is completely fulfilled, select the 

Set as Resolved checkbox. Click OK.
4.	 Close the job file.

	 Note
Selecting the Set as Resolved checkbox closes the 
design work order.
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4.5	 Configure metered energy

	 Note
Configuration of energy metering is only required 
when smart meters are used to measure energy 
consumption. Otherwise, this step can be skipped.

Preparations
Before you start creating the configurations for metered 
energy, make sure to:
•	 Obtain and read the most recent documentation of 

the selected meter
•	 Make sure that you understand the specifications of 

the selected meter and how to implement it
•	 Always follow the installation manual of the meter; 

contact the support line of the manufacturer of the 
meter in case of any questions
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4.5.1	 Open job file from the cloud

	 Important
Make sure that you save the job file to the cloud 
and close it before you start the procedures in this 
section.

1	 Open System Builder and check if it’s connected to 
the Interact Retail cloud. 

 	

	 If not, login to the cloud. See section 4.4.11 Save job 
file to the cloud.

2	 On the File menu, click Open and select Open Job 
From Cloud.

3	 Find and select the applicable work order. Click OK.
4	 Continue configuring Modbus metering:

•	 Modbus RS-485: see section 4.5.2 Configure 
Modbus RS-485 metering

•	 Modbus IP: see section 4.5.3 Configure Modbus IP 
metering

4.5.2	 Configure Modbus RS-485 metering
There are multiple methods to configure RS-485 
metering: 
•	 Using an Ethernet Bridge (PDEB) or Ethernet Gateway 

(PDEG)
•	 Using a RS-485 Gateway (DDNG485)

	 Note
Although the configuration of the meter is identical 
between the devices, there are some differences in 
the configuration of the gateway. 
•	 Procedures that start with an Important 

notification are only applicable for the mentioned 
situation.

•	 Procedures without a notification are generic and 
applicable for all situations.
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Configure PDDEG-S Site Gateway 

	 Important
This procedure is only applicable when configuring 
Modbus RS 485 metering using a PDEB or PDEG.

1.	 In the System view, select the PDDEG-S.
2.	 On the Ports tab:

a.	 Change the setting Use static IP address to True.
b.	 Click  Add and select  IPv4 Port.

3.	 Configure the IPv4 port using the following settings:
a.	 Port type		  DyNet2
b.	 Mode			   Server
c.	 Port Number	 50000
d.	 Protocol		  TCP
e.	 Secure port		 False
f.	 Connection	 	 Spur
g.	 Area zero transmit	Disabled
h.	 Sign on at start up	Enabled

3
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4.	 On the Routing tab, click  New Routing to add 
additional routs. Use the dropdowns to configure the 
routs. See the image for all settings:
a.	 IPv4 Port 1
b.	 Web Socket Port 1
c.	 Internal Messages
d.	 Metrics Collection.

4
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Add gateway
1.	 In the System view, select the PDDEG-S.
2.	 On the tab Create Device, select the tab Network 

Devices. 
3.	 Double-click the PDEB, PDEG or DDNG485.

	 Note
Make sure to add the correct device to the job file.

Add Modbus meter
1.	 In the System view, select the inserted gateway 

(PDEB, PDEG or DDNG485).
2.	 On the tab Create Device, select the tab Meters.
3.	 Under Modbus Meter, select the correct meter from 

the list;
	 Or: Insert a user-defined meter:

a.	 Click Manage Custom Meters in case the meter 
is not in the list. See Configure custom Modbus 
meter how to configure the custom meter.

b.	 Under User-defined Modbus Meters, find the 
custom meter. Drag and drop it under the inserted 
gateway (PDEB, PDEG or DDNG485).

3
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Configure custom Modbus meter
When you have selected to manage a custom meter:

1.	 Click Import and find a pre-configured configuration 
file of the meter in the file system. Select the file and 
click Open.

	 Note
This document shows a pre-configured Carel meter.

Or: Configure a custom meter from scratch:
a.	 Click Add Meter.
b.	 Click Add Line and Add Register for every phase 

the meter reads.
c.	 Configure the Active Energy Register with an 

Active Power Modbus Address, correct Data 
length and Data format according to the technical 
documentation that belongs to the meter.

	 Note
Add three lines and three registers for a 3-phase meter.

2.	 Click OK.
3.	 Insert the meter under the gateway  

(see Add Modbus meter).

1
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Enable Modbus meter
1.	 In the System view, select the inserted meter.
2.	 Select the tab Device Properties.
3.	 In the section Modbus Meter:

a.	 Make sure to Enable the meter.
b.	 Configure the Meter Address in a range between 

0 to 255.
	  

	 Note
Make sure to use the identical meter address as the 
address configured on the Modbus meter.

	 4.5	 Configure metered energy
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Configure Power Zones
1.	 In the System view, select the inserted meter.
2.	 Select the Modbus Configuration Editor tab.
3.	 Select the checkbox to enable the Active energy SE 

(kWh) register (Carel meters use address 52).
4.	 In the column Power Zone, select an appropriate 

Power Zone to the Active Energy register.

2

3

4
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Configure PDEB/PDEG as Modbus gateway

	 Important
This procedure is only applicable when configuring 
Modbus RS 485 metering using a PDEB or PDEG.

1.	 In the System view, select the PDEG (or PDEB).
2.	 On the Ports tab, configure the listed settings on the 

PDEG or PDEB:
a.	 IP Address
b.	 Gateway
c.	 Subnet

	 Note
The IP address of the PDEG or PDEB must be in the 
same range as the IP address of the PDDEG-S.

3.	 Make sure that you have the Comm Port 1 and IPv4 
Port 1 available. Delete any other port. 

4.	 At IP Address / Hostname, fill in the IP address of the 
PDDEG-S Site Gateway.

5.	 On the Ports tab, select Comm Port 1.
6.	 Configure the settings for Comm Port 1. See the 

image for all details.

3 4
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7.	 On the Routing tab, cross check the routing setting.
8.	 On the Metrics tab, make sure that the Polling 

Interval for Total Energy Consumption is set to 15 
minutes (00:15:00).

9.	 Save the job file to the cloud. See section 4.4.11 Save 
job file to the cloud.

7

8
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Configure DDNG485 as Modbus gateway

	 Important
This procedure is only applicable when configuring 
Modbus RS 485 metering using a DDNG485.

1.	 In the System view, select the DDNG485.
2.	 On the Ports tab, select Comm Port 1.
3.	 Configure the settings for Comm Port 1. See the 

image for all details.

2 3
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4.	 Repeat the previous steps for Comm Port 2. See the 
image for all details.

4

	 4.5	 Configure metered energy
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5.	 On the Routing tab, cross check the routing setting. 
See the image for all details.

6.	 On the Metrics tab, make sure that the Polling 
Interval for Total Energy Consumption is set to  
15 minutes (00:15:00).

7.	 Save the job file to the cloud. See section 4.4.11 Save 
job file to the cloud.

6

5
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4.5.3	 Configure Modbus IP metering

Add IP meter
1.	 In the System view, select the site gateway 

(PDDEG-S).
2.	 On the tab Create Device, select the tab Meters.
3.	 Click Manage Custom Meters. See Configure custom 

IP meter how to configure the custom meter.
4.	 Under User-defined Modbus Meters, find the custom 

meter. Drag and drop it under the site gateway 
(PDDEG-S).

4

3
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Configure custom IP meter
When you have selected to manage a custom meter:

1.	 Click Import and find a pre-configured configuration 
file of the meter in the file system. Select the file and 
click Open.

	 Or: Configure a custom meter from scratch:
a.	 Click Add Meter.
b.	 Click Add Line and Add Register for every phase 

the meter reads.
c.	 Configure the Active Energy Register with an 

Active Power Modbus Address, correct Data 
length and Data format according to the technical 
documentation that belongs to the meter.

	 Note
For a 3-phase meter you need to add three lines and 
three registers.

2.	 Click OK.
3.	 Insert the meter under the gateway  

(see Add IP meter).

2
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Enable IP meter
1.	 In the System view, select the inserted meter.
2.	 Select the tab Device Properties.
3.	 In the section Modbus Meter:

a.	 Make sure to Enable the meter.
b.	 Configure the IPv4 Address of the meter.
c.	 Configure the Port Number of the meter.	  

	 Note
•	 The IP address and Port Number parameters are 

configured on the IP meter.
•	 In some cases, also the Meter address can be 

configured on the IP meter. Always make sure to 
use the identical meter address as the address 
configured on the meter.

2
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Configure Power Zones
1.	 In the System view, select the inserted meter.
2.	 Select the Modbus Configuration Editor tab.
3.	 Select the checkbox to enable the Active energy 

register.
4.	 In the column Power Zone, select an appropriate 

Power Zone to the Active Energy register.

4
3
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Configure PDDEG-S as Modbus gateway
1.	 In the System view, select the site gateway 

(PDDEG-S).
2.	 On the Metrics tab, make sure that the Polling 

Interval for Total Energy Consumption is set to 15 
minutes (00:15:00).

3.	 Save the job file to the cloud. See section 4.4.11 Save 
job file to the cloud.

	 4.5	 Configure metered energy
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4.6	 Plan installation

4.6.1	 Order hardware
In System Designer, following step 16. Generate Reports 
and 17. Produce Documentation you created the files 
that provide you an overview of the hardware to order.
In the Project Template, see page 21 and 22 for the Bill of 
Materials (BoM) for both controls and luminaires. Filling 
in these pages helps you to process the ordering of the 
hardware.

4.6.2	 Perform a connectivity audit
The connectivity audit can be done before visiting the 
customer site. Prior to the connectivity audit, make sure 
that the IT department of the customer prepares the 
local network as follows:
•	 Ability to reach all specific endpoints listed in the 

appendix of the Security Statement related to the 
system

•	 Manually configure the port of the IT switch 
connecting with the Site Gateway (PDDEG-S) to  
100 Mbps/Full duplex 

See the FLX Multisite Toolbox Technical Note for more 
information. This document can be found on the Signify 
Partner Portal.
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4.7	 Plan commissioning

4.7.1	 Request work order
For the onsite activities, a request for a work order for 
installation and validation must be created by the market 
for execution at GSO. The work order must be assigned 
to the installer and/or site engineer.

The installer receives an email when the work order is 
assigned.
 

4.7.2	 Install Philips Dynalite Site Enabler app
Before going onsite, install the Site Enabler app on your 
phone. The app is used to:
•	 Preview tasks in the work order
•	 Provision gateway to the cloud
•	 End-to-end validation
•	 Deploy and check concepts and schedules from the 

cloud
•	 Resolve the work order, the site shows up as  

“Ready to use”.

The app forces the user to follow a strict order in the 
commissioning. It’s not possible to switch to a new task 
before finalizing the previous one.

Download the Philips Dynalite Site Enabler app
The Site Enabler app is supported on Android 
and iOS. 

•	 For Android, go to the Play Store. Search for ‘site 
enabler’, select and install it.

•	 For iOS, go to the App Store. Search for ‘site enabler’, 
select and install it.
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Login to the app and select work order
It’s recommended to check if the Site Enabler app 
functions as expected and prepare for the onsite 
commissioning.

1.	 Open the app on your device.
2.	 Select your region.
3.	 Enter your username (email address). Tap Next.
4.	 Enter your password. Tap Sign in.
5.	 Select the work order.

	 Tip
You can use the Demo mode to familiarize yourself 
with the app. The work orders are not related to real 
sites, which allows you to play around freely. 
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Before you start with the onsite activities, make sure to 
complete to plan the installation and commissioning well 
in advance. See the sections 4.6 Plan installation and  
4.7 Plan commissioning for more information.

Onsite activities consist of the following:
•	 Establish connectivity to the internet for connection 

to the Interact cloud.
•	 Installation and wiring of the luminaires, including 

power and DALI, following the local guidelines and 
directives.

•	 Installation and wiring of the Dynalite network 
controller, including sensors and user interfaces, 
according to the documentation produced during the 
offsite preparation.

•	 Additional commissioning of the controllers, assigning 
the luminaires to the correct parent areas, child areas 
and logical channels.

•	 Validate the system to enable the site in the cloud.
•	 Deploy concepts and schedules from the cloud.
 

5.1	 Prerequisites

Before starting with commissioning the Multisite system, 
make sure the following steps are completed:
•	 Luminaires installed, wired, and powered ON
•	 Controllers are installed in the distribution board, 

wired (both power and Dynet) according to the 
corresponding installation instruction and powered 
ON.

	 Important
The power supply to the Site Gateway must be 
continuously available. It’s not allowed to switch off 
the device during the night.
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•	 Sensors and user interfaces are installed and 
wired according to the corresponding installation 
instructions.

•	 Basic checks have been performed to make sure the 
controllers are wired correctly.

•	 The port of the IT switch of the customer connecting 
with the Site Gateway (PDDEG-S) is configured to  
100 Mbps/Full duplex.

•	 A connectivity audit is successfully performed 
using the Interact Connectivity Toolbox software. 
Otherwise assure yourself to do so before staring 
the commissioning. See section 4.6.2 Perform a 
connectivity audit. 

	 Note
The following ports must be open for outbound 
traffic only:
•	 53 (DNS)
•	 123 (NTP)
•	 443 (HTTPS)
•	 5671 (MQTT or AMQP)
•	 8883 (MQTT or AMQP)
All specific endpoints are listed in the appendix of 
the Security Statement related to the system.

•	 The Site Gateway is connected to the cloud.

	 Note
The system requires an internet connection that is 
available 24/7.

•	 The Site Enabler app is installed on the phone of 
the commissioning engineer and the workorder is 
checked using the mobile app. See section 4.7.2 
Install Philips Dynalite Site Enabler app.

•	 A DTK-622USB PC node is available.
•	 The recommended version of System Builder is 

installed on the PC of the commissioning engineer, 
and the Technical license is enabled.

	 Important
For the recommended version of System Builder, see 
the System Release Notes.

•	 The latest firmware of the Site Gateway is 
downloaded from the Signify Partner Portal.
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5.2	 Connect the system to the cloud

5.2.1	 Discover gateway

Prepare gateway discovery
1.	 Connect the PC to the internet and run the 

recommended version of System Builder.

Login to the cloud
1.	 On the Tools menu, click Online Accounts….
2.	 Click  Add and select Retail Account….
3.	 Select the Region and click OK.
4.	 Select your account to login to. If required, fill in your 

password.

	 Note
•	 Your user account must be registered in 

Microsoft Azure Active Directory before you can 
login to the Retail Account.

•	 The status bar at the bottom shows your 
connection status and the region you’re 
connected to.
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Download job file
1.	 On the File menu, click Open and select  

Open Job From Cloud.
2.	 Select the Region in the popup menu.
3.	 Select the work order that belongs to the site.  

Click OK.

It may take some moments until the file is successfully 
loaded.
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Localize and upgrade gateway

	 Important
Make sure to download and extract the latest 
firmware file from www.dynalite.org first!

1.	 In the System view, select the PDDEG-S. 
2.	 On the Tools menu, click Localize Devices by Sign-on.
3.	 Push the sign-on button on the gateway. In the 

Localize Device dialog box, click Localize.
4.	 Right-click the device and select Firmware Upgrade.
5.	 Select the new firmware file and click OK.
6.	 Wait until the process is finished.
7.	 Right-click the device and select Save To Device. 

Select Resave all device data and click OK.

	 5.2	 Establish connectivity

http://www.dynalite.org
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Configure network settings
1.	 I In the System view, select the PDDEG-S.  

Click  Advanced.
2.	 On the Ports tab, in the section IPv4, set the Use 

static IP address either to:
•	 False

	 The gateway obtains a dynamic IP address from the 
customer IT network, no additional configuration 
required.
•	 True

	 Configure the static IP and network settings manually 
using the steps below.

3.	 When configuring a static IP address, manually set:
•	 IP Address (of the PDDEG-S)
•	 IP address of the (default) Gateway (router)
•	 Subnet mask 
•	 DNS server
•	 Alternative DNS server

4.	 Right-click the device and select Save To Device. 
Select Resave all device data and click OK.

5.	 Right-click the device and select Send Reboot to 
apply the new network configuration.

6.	 In the File menu, click Save As and select Save Job To 
Cloud. Make sure to use a proper Work Order.

7.	 Close the job file.

1
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5.2.2	 Establish connectivity
Connectivity to the internet can be established via two 
methods, depending on the preference of the customer: 
•	 Customer IT 
•	 Signify connectivity service using a 4G modem

Setup internet connectivity via the customer IT network
The IT department of the customer provides an 
outbound IT connection at the site. This connection must 
comply to the requirements as mentioned in the FLX 
Multisite Security Statement.

The Site Enabler app tests the connectivity before 
assigning the gateway.
1.	 Login to the app and select the work order.
2.	 Tap Start commissioning. 
3.	 Tap Establish connectivity. Select Use available 

internet connection.
4.	 The system checks the internet connection.
5.	 Tap Done.

	 5.2	 Establish connectivity
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Setup internet connectivity with 4G modem
For the Signify Connectivity Service, Signify delivers a 
4G modem that is configured for installation at the site 
of the customer. After installation, activate the modem 
using the Site Enabler app.

The Site Enabler app tests the connectivity before 
assigning the gateway.
1.	 Login to the app and select the work order.
2.	 Tap Start commissioning. 
3.	 Tap Establish connectivity. Select Set up 4G 

connectivity device.
4.	 Power up the 4G connectivity device and tap 

Continue.
5.	 Scan the ICCID barcode on the rear of the 

connectivity device;
	 Or: Enter the ICCID code manually and tap Submit.
6.	 Tap Done.

	 5.2	 Establish connectivity
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5.2.3	 Activate Site Gateway

	 Note
You can activate the gateway after you successfully 
established connectivity.

1.	 In the app, tap Assign Site Gateway.
2.	 Check if the bottom led ( ) flashes:

•	 If so, tap Yes.
•	 If not, tap No, follow the steps in the app.

3.	 Scan the QR-code.
4.	 After reading the message Assigning in progress,  

tap OK. The assigning process starts. 

	 Important
Wait for the gateway to be assigned. Assigning the 
gateway takes up to 30 minutes.

	 5.2	 Establish connectivity
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5.3	 Commissioning

5.3.1	 Link System Builder job file to the site devices
1.	 Connect the PC to the system using the PC Node 

(DTK622), run System Builder and open the job file 
from the cloud.

2.	 In the System view, select a Load Controller, 
Integration Device, User interface or Sensor.

3.	 On the Tools menu, click Localize Devices by Sign-on.
4.	 Push the sign-on button on the device. In the Localize 

Device dialog box, click Localize.

	 Tip
You can localize sensors that are difficult to reach 
with aiming a torch to the device or use a dedicated 
IR remote control.

5.	 Repeat for all devices in the network.
6.	 Right-click the device and select Save To Device. 

Select Resave all device data and click OK.
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5.3.2	 Configure DALI individual addressing

	 Note
Applicable for the DDBC120-DALI, DDBC300-D, and 
DDBC320-D controllers.

When all DALI-ballasts are enumerated:
1.	 On the Outputs tab (A), map the Physical channels (B) 

to the correct Child areas (C) and Logical Channels 
(D).

2.	 In the column Base Link Area (E), map the number of 
the Child area (C) with the parent area.

3.	 Fill in the Load (F) in Watts and select the Power 
Category (G) of the physical channel.

4.	 Right-click the device and select Save To Device.
Select Resave all device data and click OK.

5.	 Repeat for all other DALI individual addressing 
devices.

A
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5.3.3	 Configure sensors

	 Note
In case of DALI sensors connected to a DDBC120-
DALI controller. Make sure to enumerate these 
devices and assign the correct box numbers.

1.	 Make sure to localize the sensors for box number 
assignment. Use a torch or IR remote control to 
localize.

2.	 Right-click the sensor and select Sensor 
Configuration Wizard. Configure the sensor in line 
with customer expectations. Note: Always use 
presets as motion actions:
a.	 No motion timeout:		 Set time
b.	 On Preset:	 Action (for example: High)
c.	 Off preset:	 Action (for example: Off).
d.	 Enable resend inhibit: 	 Enabled
e.	 Resend inhibit period:	 Set time 

	 Note: make sure the time is shorter than the timeout 
time.

	 5.3	 Commissioning
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3.	 Check the Join byte:
•	 Occupancy sensing: 0x81
•	 Daylight harvesting: 0x82

4.	 Right-click the device and select Save To Device. 
Select Save modified device data and click OK.

5.	 Validate if the sensors work as expected.
6.	 Repeat for the other sensors.

	 Note
When configuring sensors for daylight harvesting, 
make sure to calibrate the sensors.

	 5.3	 Commissioning
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5.3.4	 Configure user interfaces
1.	 Make sure to localize the user interfaces for box 

number assignment. Use a torch or IR remote control 
to localize.

2.	 Configure the user interfaces according to the 
wishes of the customer.

3.	 Check the Join byte: 0x83.
4.	 Right-click the device and select Save To Device. 

Select Save modified device data and click OK.
5.	 Validate if the user interfaces work as expected.
6.	 Repeat for the other user interfaces.

	 5.3	 Commissioning



130	 Chapter contents

05	 Onsite installation, commissioning and validation

	 Main contents

5.3.5	 Configure Dry contact connections
1.	 Make sure to localize the Dry contact interfaces for 

box number assignment.
2.	 Configure the Dry contact interfaces according to 

the wishes of the customer.
3.	 Check if the offsite preparation has been carried out 

correctly. See section 4.4.7 Configure controller for 
more information.

4.	 When configuring for Alarm integration, finalize with 
the following settings:
a.	 Set the Function to Custom.
b.	 On the PDDEG-S, start Task 5 (Alarm armed)
c.	 On the PDDEG-S, start Task 4 (Alarm disarmed)

5.	 Right-click the device and select Save To Device. 
Select Save modified device data and click OK. 

6.	 Validate if the Dry contact interfaces work as 
expected. 

7.	 Repeat for the other Dry contact interfaces.

4

	 5.3	 Commissioning
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5.3.6	 Save final job file 
1.	 Make sure System Builder is connected to the 

Interact Retail account.
2.	 On the File menu, click Save As and select  

Save Job To Cloud. 
3.	 In the Work Order Selection menu, select the  

Region: Europe. 
4.	 Find and select the applicable work order, then  

click OK. 

1
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5.4	 Commission metered energy

	 Note
Commissioning of energy metering is only required 
when smart meters are used to measure energy 
consumption. Otherwise, this step can be skipped.

Preparations
Before you start commissioning metered energy, make 
sure to:
•	 Upgrade the firmware of the Dynalite devices:
•	 PDDEG-S	 	 1.23 or higher
•	 PDEB/PDEG	 3.58 or higher
•	 DDNG485		 latest version
•	 Consider updating the firmware of the meter
•	 Always follow the installation manual of the meter; 

contact the support line of the manufacturer of the 
meter in case of any questions.

 

5.4.1	 Configure the smart meter
Configure the meter as follows:
•	 Meter Address
•	 Baud Rate (supported are 9600, 19200 and 38400)
•	 Data Format parameters: 

•	 Communication	 Half-duplex
•	 Data bits		  8
•	 Parity			  None
•	 Stop bits		  1

For Modbus IP meters also:
•	 Meter IP address
•	 Port

	 Note
•	 Make sure that the configured IP address is 

identical to the IP address configured in System 
Builder.

•	 Make sure the configured Port is identical to the 
Port configured in System Builder.

Also, verify the general electrical configuration of 
the meter and, if applicable, configure the current 
transformers ratio.
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5.4.2	 Verify metered energy

1.	 In the System view, click on the meter to verify.
2.	 On the Modbus Configuration Editor tab, right-click 

on the Active Energy register and select Request 
Register Value.

3.	 Confirm that the Register Value is populated and 
verify if the value shown matches with the expected 
consumption.

4.	 Click the tab Network Log. 
a.	 In the columns Description, find the Binary Metric 

Data. 
b.	 In the column Local Time, confirm that there is a 

package of this kind generated every 15 minutes.

	 Note
After approximately one hour, the energy dashboard 
starts showing data from that is generated by 
metered energy.  

4
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5.5	 Validate site

5.5.1	 Validate Areas, Child Areas and Logical Channels
1.	 In the app, tap Validate site installation.
2.	 Tap the name of an parent area, child area or logical 

channel. 
3.	 Tap the buttons and check visually if the lights 

respond accordingly. Correct if necessary. 
4.	 When the lights respond as expected, tap  

Yes, confirm.

	 Note
A green checkmark shows for all areas, child areas 
and logical channels that have been validated.

5.	 Tap < and continue with the next. 
6.	 Repeat for all other parent areas, child areas and 

logical channels.
7.	 Make sure that both the Site and all areas show  

All validated.
8.	 When finished, tap Save. Tap < to return to the  

main menu.
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5.5.2	 Deploy Concepts and Schedules

	 Note
Make sure that the default concept and schedule is 
prepared in the cloud. See section 4.3.6 Add concept 
and 4.3.7 Add schedule for more information.

In the app, tap Deploy concept and schedule. 
Tap Yes, confirm to deploy.

	 5.5	 Validate site
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5.5.3	 Validate concept and schedule
1.	 In the app, tap Validate concept and schedule.
2.	 Tap the name of a Parent area. 
3.	 Tap the buttons and check visually if the lights 

respond accordingly. Correct if necessary. 
4.	 When the lights respond as expected, tap  

Yes, confirm.

	 Note
A green checkmark shows for all areas, child areas 
and logical channels that have been validated.

5.	 Tap < and repeat for all other Parent areas.
6.	 When finished, tap Save. Tap < to return to the  

main menu.

	 5.5	 Validate site
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5.5.4	 Resolve work order
1.	 Tap Resolve work order when you are ready with 

commissioning. 
2.	 Tap Yes, Confirm. 
3.	 Tap < to return to the main menu. Now you can:

•	 Tap View commissioning to check the 
commissioning.

•	 Tap Reopen to eventually reopen the work order. 
Tap Yes, confirm to reopen.

	 5.5	 Validate site
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5.6	 Handover to the customer

After resolving the workorder, the Multisite system is 
fully commissioned. The site engineer delivers the project 
to the market organization.

At this stage, the market organizes a formal handshake 
with the customer, which can be held on-site or 
remotely. For a successful handover, prepare the 
following:
•	 Create an OTRS ticket to add a user account
•	 Create an OTRS ticket to assign the appropriate role 

to the user (Format or Facility manager)
•	 Provide a copy of the latest User Guide.  

The user guide is available via the Signify Partner 
Portal or the Interact Multisite System Manager.

•	 Using the user guide, train the customer on the usage 
of the system.

An Energy report will be generated each month. This 
report can be used to engage with the customer to gain 
feedback on the system and discuss further projects.
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6.1	 Frequently asked questions

6.1.1	 Technical support

General
1.	 Login to the Interact Multisite System Manager.
2.	 Hover over 	to see the dropdown with additional 

information. A green dot shows in the icon when items 
are updated. 

3.	 Click on either Release notes or Help & 
documentation. The flag Updated shows if new 
revisions are available.

Personnel of Signify
Signify personnel has access to the Signify only pages 
on the Partner Portal. Here you can find more detailed 
information.

	 Important
Don’t share the information on the Signify only pages 
with the customer.
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6.1.2	 Ticketing system (C4CS)

Personnel of Signify
Follow the Learning Path Systems Support ticketing 
in C4CS. The Learning Path explains how to submit a 
ticket. Markets and System Centers to create a Business 
Support Request ticket (BSR) providing the necessary 
detail, including specified architecture and owner.

Personnel of Customer System Integrators (CSIs)
1.	 Login to the Signify Partner Portal.
2.	 Click on Technical support.
3.	 Search the knowledge base for any information on 

the subject you want help for.
4.	 If you don’t find relevant information, click Request 

Support at the bottom of the search result.
5.	 Fill in the webform adding all mandatory details 

required to support you.

	 6.1	 Frequently asked questions
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6.1.3	 Questions and answers

Q: How can I get access to the dashboard?
A: Create a ticket to request a new user with the correct 
user profile (see chapter 3.2 Users and user roles) and 
permissions for access to a particular site or format.

Q: How can I get access to the dashboard as a designer/
field engineer?
A: An additional work order is required to get permission 
to access a particular site.

Q: How can I submit a change request after completion 
of the project?
A: Depends on who want to submit the request, check 
which steps to follow and either reopen an existing ticket 
(engineer) or create a new one.

Q: My license is expired or expiring soon.
A: Create a ticket to extend your license.

Q: I want to add new services to my license.
A: Create a ticket to request to add services to  
your license.

Q: The system doesn’t work properly.
A: Check the connectivity status of the system  
(check LEDs on the gateway)
A: Create a ticket to request assistance.

Q: I experience a hardware failure (parts of the system 
do not function as expected). 
A: Create a ticket to request assistance.

Q: I forgot my password.
A: The password is linked to your user account and not 
handled by Signify. Contact your IT representative or 
provider.

Q: I have a new email-address.
A: Create a ticket to request a new user, refer to your 
old email-address to point to the user profile and 
permissions.

Q: As a designer I can’t upload the jobfile to the cloud or 
see the Configuration tab on the dashboard.
A: The wrong permissions are assigned to your user 
account. Create a ticket to change these permissions.

	 6.1	 Frequently asked questions
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IT and lighting network components

Gateway

LCN5320/LCN5321 Indoor 4G router
For the Signify Connectivity Service, Signify delivers a 4G 
router that is configured for installation at the site of the 
customer.
The 4G router requires the LCN5323 12 Vdc power supply.

PDDEG-S Ethernet Gateway
The Philips Dynalite PDDEG-S provides gateway services 
between Ethernet and DyNet devices, enabling secure 
online access to the Philips lighting control system.

The gateway enables lighting control via the Philips 
Dynalite Site Enabler app and Interact Multisite System 
Manager.

	 Important
The PDEG Ethernet Gateway is not compatible for 
use in Multisite installations.
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Components wired topology

DDBC120-DALI MultiMaster DALI Driver controller
The Philips Dynalite DDBC120-DALI delivers cost-
effective control of DALI drivers through provision of a 
full universe of 64 DALI drivers. The device communicates 
seamlessly with Philips Dynalite DALI sensors and user 
interfaces.

DDBC300-D 3 Universe DALI controller
The DDBC300-DALI delivers cost-effective control 
of DALI high frequency fluorescent drivers through 
provision of three full universes totaling 192 DALI 
addresses.

	 IT and lighting network components
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DDBC320-D DALI Driver Controller
The Philips Dynalite DDBC320-D features three DALI 
outputs, allowing control of up to 192 DALI devices. It 
also features 3 x 20 A feed-through switched circuits for 
DALI driver mains supply.

DDBC1200 Signal dimmer controller
The Philips Dynalite DDBC1200 features 12 independent 
output channels, each selectable to DALI Broadcast, 
0-10 V/1-10 V or DSI. The device can also be linked to 
a separate relay module for control of 0-10 V/1-10V 
drivers.

	 IT and lighting network components



147	 Chapter contents

Appendix A - System components

	 Main contents

DDRC420FR Relay controller
The Philips Dynalite DDRC420FR provides control of any 
type of switched load. This four-channel device supports 
all types of switched loads up to 20 A inductive.

DDRC1220FR-GL Relay controller
The Philips Dynalite DDRC1220FR-GL provides control of 
any type of switched load. All types of switched loads up 
to 20 A inductive are supported. The maximum load may 
be limited by 500 A inrush rating.

	 IT and lighting network components
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DDMIDC8 Dry contact connections
Dry contact connections allow installation in electrical 
wall boxes for easy integration with third-party user 
interfaces. With this option it is possible to integrate 
security systems with the lighting system, by receiving 
input from the security system and run a special task 
according to the requirements. Multiple DDMIDC8 
devices can be used in the system to add more dry-
contact inputs required in a project.

DDNG485 RS-485/DMX512 Gateway
The Philips Dynalite DDNG485 is a flexible network 
communications bridge designed for RS-485 networks. 
The two opto-isolated RS-485 ports enable the 
DDNG485 to implement a trunk and spur topology on 
large project sites, with the bridge providing a high-
speed backbone opto-coupled to many lower speed 
spurs.

	 IT and lighting network components
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User interfaces

PDTS Touch screen
The PDTS offers intelligent control and direct access 
to scheduling, scene editing, diagnostics and local 
environmental sensing.

PAxPA/E Antumbra
The Philips Antumbra series provide a wide range of 
flexible user interfaces, incorporating the latest in field 
effect technology. The contemporary design features 
several button configurations, with each button capable 
of local or site-wide control functions.
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Optional components

Sensors

DUS360CR Multifunction sensor
The Philips Dynalite DUS360CR is a recess mountable 
360 degrees multifunction sensor that combines motion 
detection (PIR), infrared remote-control reception (IR) 
and ambient light level detection (PE) into one device in 
multiple applications.

DDNP1501 Network Power Supply
The Philips Dynalite DDNP1501 is a 15 V DC 1.5 A regulated 
power supply designed to supplement the DyNet 
network DC supply.
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Signify and partner roles

Explanation of the symbols
    Possible	

	    For validation purposes

Activities / Roles Operations
(Signify only)

Contractor Light Designer 
(VE-Designer)

Controls
Designer

Installer
(VE-Engineer)

Operations (Customer management/System updates)

User management (e.g. work orders, etc.)

Lighting and venue enablement design

Controls design

Site commissioning 

Assets and health

Light control (Concepts and Schedules)

Configuration (Design)

Energy monitoring

SDK access

Analytics
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Customer and service provider roles

Explanation of the symbols
    Possible	

	    Possible, but with limited functionality
	    Local override only

Activities / Roles Facility 
manager

Format 
manager

Store 
manager

External app 
developer

Analyst

User management (e.g. work orders, etc.)

Assets and health

Light control (Concepts and Schedules)

Configuration (Design)

Energy monitoring

SDK access

Analytics

Handover to end user
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Create custom meter

See the sections 4.5.2 Configure Modbus RS-485 
metering and 4.5.3 Configure Modbus IP metering for 
more information how to configure the meter in System 
Builder.
1.	 Obtain the latest documentation of the meter that 

contains the details.
2.	 Make sure to understand the meter and its 

configuration.
3.	 It is advised to perform a proof of concept with the 

meter before committing to the meter:
• In System Builder, create the meter
• Add the lines and registers
• Configure the registers

4.	 After the Proof of Concept is successful, you can 
start implementing the meter in the installation.

	 Note
The pictures on this page show an example how the 
technical documentation of a meter manufacturer 
is translated into a custom meter configuration in 
System Builder.

Appendix C - Create custom meter
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D.1	 Introduction

D.1.1	 Purpose
This appendix is meant for use when upgrading an Store 
Kit (or StoreWise kit) with a touchscreen to Multisite.

After identifying the system version of the kit, the 
upgrade procedure consists of two main steps, like the 
standard commissioning flow:
•	 Offsite preparation
•	 Onsite commissioning
 

D.1.2	 Prerequisites
Before starting with the upgrade, make sure to follow 
the standard commissioning flow until the point that you 
start designing the system (section 4.2 and further):
•	 System introduction (see chapter 2)
	 Architecture, IT requirements and configuration
•	 Intake (see chapter 3)
	 Collect all required information including the 

customer, project, lighting control etcetera.
•	 Onboarding (see section 4.1)
	 Setup of the cloud, including customer, site, format, 

contract and license, users and roles, etcetera.

D.1.3	 Scope
The instructions in this document are generic for all 
kit systems with a touchscreen, except when explicitly 
indicated:
•	 For DTP100
	 StoreWise kit systems using a DTP100 touchscreen
•	 For PDTS
	 Store Kit systems using a PDTS touchscreen
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D.1.4	 Preparations
For a successful upgrade, make sure prepare the 
following:
•	 Determine the type of touchscreen used in the 

system:
•	 StoreWise Kit 1.0 with DTP100 touchscreen
•	 Store Kit 2.x with PDTS touchscreen

•	 Laptop running the latest version of System Builder 
(SB) with Technician License

•	 DTK622 PC node
For StoreWise kit with DTP100
•	 USB thumb drive (size: ≤4 GB)
•	 Mini USB type B to USB type A adapter
•	 Job file of the standard StoreWise v1.0
•	 Local Control UI v1.0.0 install package, specific for  

the DTP100
For Store Kit with PDTS
•	 Job file of the factory default Store Kit 2.x 
•	 Local Control UI v1.0.0 install package, specific for  

the PDTS

	 Note
All files can be downloaded from the Commissioning 
folder of Multisite on the Partner Portal.

Figure 1. DTP100 touchscreen

Figure 2. PDTS touchscreen

Figure 3. USB adapter
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D.2	 Identify system version of the kit

D.2.1	 For DTP100
•	 The user interface (UI) shows in a blue and white 

theme with Philips StoreWise logos
•	 The version number shows 1.1.27 or 1.1.28

	 Note
Submit a C4CS ticket to ask for technical support 
in case the version number of the UI is not 1.1.27 or 
1.1.28.
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Default configuration of the lighting control 

Output:
•	 Sales floor (Area 2):

•	 LC1 to LC8: DALI CH 1 to 8
•	 LC9 to LC11: Relay CH 1 to 3

•	 Storage area (Area 3):
•	 LC1: DALI CH9/10
•	 LC2: DALI CH11/12
•	 LC3: Relay CH4

Input (Dry contact):
•	 DC1: Sales floor: Trading
•	 DC2: Sales floor: Stocking
•	 DC3: Sales floor: Closed
•	 DC4: Custom: Custom preset 01
•	 DC5: Custom: Custom preset 02
•	 DC6: Custom: Custom preset 03
•	 DC7: Others: Panic NO
•	 DC8: Others: Panic NC

	 Note
Remote assistance from the site may help to confirm 
if the actual configuration is different from the 
factory default.

Submit a C4CS ticket in case the actual configuration 
differs from the factory default.
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D.2.2	 For PDTS
•	 The user interface (UI) shows a grey and white theme
•	 Login and check the About menu, the version number 

shows 1.6.8 or higher

	 Note
Submit a C4CS ticket to ask for technical support 
in case the version number of the UI is not 1.6.8 or 
higher.

	 D.2	 Identify system version of the kit
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Default configuration of the lighting control
Output:
•	 Sales floor (Area 2):

•	 DALI CH 1 to 8
•	 Relay CH 1 to 8

•	 Back of house (Area 3):
•	 DALI CH 9/10/12
•	 Relay: CH9/10

•	 Outdoor (Area 4)
•	 DALI CH11 (Signage)
•	 Relay CH11/12

Input (Dry contact):
•	 DC1: Sales floor Open; Back of house Open
•	 DC2: Sales floor Stocking; Back of house Open
•	 DC3: Sales floor Closed; Back of house Closed
•	 DC4: Sales floor toggle ON/OFF
•	 DC5: Back of house toggle ON/OFF
•	 DC6: PANIC NO or Outdoor toggle ON/OFF *)
•	 DC7: PANIC NC or PANIC 30 minutes *)
•	 DC8: ALARM

	 Note
*) Definition changed since system version 2.2.
Submit a C4CS ticket in case the actual configuration 
differs from the factory default.

	 D.2	 Identify system version of the kit
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D.3	 Offsite preparations

In this step, the original job file of the kit will be modified 
to match with the hierarchy of the Multisite logical 
configuration:

In Multisite, the names and IDs of the areas, logical 
channels, and scenes (presets) must be identical in both 
the cloud and the job file.

Each customer only can have one superset of names and 
IDs for the areas and logical channels of all sites. Each 
site uses a subset of these names and IDs, defined in a 
Format by the Project Template.
 

Multisite (Parent) Areas don’t contain any channels. 
The IDs of the Parent Areas are in System Builder 
represented as the Base Link Area number for Logical 
Channels of Child Areas that belong to a certain (Parent) 
Area.

In System Builder, use one Physical Channel in each 
Logical Channel, so that all physical channels can be 
independently managed on the cloud.

Cloud (Parent) Area Child Area Logical Channel

System Builder Base Link Area Area Logical Channel
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D.3.1	 For DTP100
StoreWise 1.0 systems using the DTP100 have two areas, 
each consisting of a few logical channels.

To upgrade to Multisite, customize the names of the 
areas and channels to the names defined in the Project 
Template (Intake form).

Figure 4. Factory default areas and channels configuration

	 D.3	 Offsite preparations
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Edit StoreWise job file
1.	 Open the downloaded factory default StoreWise 1.0 

job file.
2.	 Apply the names and IDs of the Parent Areas 

according to the hierarchy of Multisite.
	 Use the data from the Project Template.
3.	 Check if the occupation presets 5 and 6 in the 

Storage area (or Back of House) need to change ID, 
because of conflicting IDs according to the hierarchy 
of Multisite. Make sure to set these two presets to 
Hidden.

4.	 Check if any DUS360 sensor needs update of the 
presets 5 and 6 accordingly. Enable Resend inhibit 
period on the Stocking preset.

5.	 Create Child Areas according to the Project  
Template and move each channel to the 
corresponding Child Area.

6.	 Add a PDDEG-S v2 Site Gateway to the job file. 
Configure the Site Gateway following the instructions 
in section 4.4.4 Configure Site Gateway.

7.	 Save the modified job file to the cloud. Keep a backup 
of it on your local computer. 

Figure 5. Example of modified areas and channels

	 D.3	 Offsite preparations
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D.3.2	 For PDTS
Store Kit 2.x systems using the PDTS have three areas, 
each consisting of a few fixed logical channels.

To upgrade to Multisite, customize the names of the 
areas and channels to the names defined in the Project 
Template (Intake form).

Figure 6. Factory default areas and channels configuration

	 D.3	 Offsite preparations
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Edit Store Kit job file
1.	 Open the downloaded factory default Store Kit 2.x 

job file.
2.	 Apply the names and IDs of the Parent Areas 

according to the hierarchy of Multisite.
	 Use the data from the Project Template.
3.	 Check if the occupation presets 8 and 9 in the Back 

of House need to change ID, because of conflicting 
IDs according to the hierarchy of Multisite. 

4.	 Check if any DUS360 sensor needs update of the 
presets 8 and 9 accordingly. Enable Resend inhibit 
period on the Occupied preset.

5.	 Create Child Areas according to the Project Template 
and move each channel to the corresponding Child 
Area.

6.	 Remove all tasks from the PDTS.
7.	 Add a PDDEG-S v2 Site Gateway to the job file. 

Configure the Site Gateway following the instructions 
in section 4.4.4 Configure Site Gateway.

8.	 Save the modified job file to the cloud. Keep a backup 
of it on your local computer. 

	 D.3	 Offsite preparations
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D.3.3	 Prepare the touchscreen
The existing user interface on the device needs to be 
replaced with a simple UI for local control.

For each device, you can choose between two scenarios:
•	 In case the customer uses a BMS, select the Local 

Control UI without 2-hour manual override:
•	 MO_DTP100_no_2h_timer v0.3.zip
•	 MO_PDTS_v1.0RC2.zip

	 The Local Control UI simply recalls the preset that the 
user taps on the touchscreen.

•	 In case the customer doesn’t use a BMS, select the 
Local Control UI with 2-hour manual override.
•	 MO_DTP100_2h_timer v0.3.zip
•	 MO_PDTS_2h_timer v1.0RC2.zip

The Local Control UI recalls the preset that the user taps 
on the touchscreen for two hours, and then switches 
back to the Automatic schedules preset.

	 Important
Make sure to use the correct Local Control UI files, 
which are tailored to the device.

Figure 7. Local Control UI for DTP100

Figure 8. Local Control UI for PDTS

	 D.3	 Offsite preparations
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D.4	 Onsite commissioning

D.4.1	 Backup configuration
Before making any changes, it’s highly recommended to 
back up the current system configuration to:
•	 Verify if the current site configuration differs from 

the Project Template (Intake form)
•	 Rollback to the original kit configuration of the site, in 

case this is needed.

1.	 Connect the PC to the system using the DTK622  
PC node.

2.	 Use System Builder to retrieve the current system 
configuration and make a backup of the job file.

3.	 Check if the UI shows the correct version:
•	 DTP100: 1.1.27 or 1.1.28
•	 PDTS: 1.6.8 or newer

	 Note
•	 There’s no backup option available for the UI files.
•	 Submit a C4CS ticket to ask for technical support 

in case the version number of the UI doesn’t 
correspond with the specified versions.
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D.4.2	 Link job file to the site devices
1.	 Using System Builder, download the modified 

job file from the cloud. See section 5.2 Establish 
connectivity.

2.	 Sign-on and validate if the devices match the 
hierarchy in the System view of the job file, except for 
the DDBC1200 controllers.

D.4.3	 Configure the DDBC1200 controllers
In case you upgrade a kit with multiple DDBC1200 
controllers, it’s a possible that all use an identical box 
number. This will not work in Multisite. 

Set unique box numbers for all DDBC1200s
1.	 Leave the box number for the primary DDBC1200 as 

set in the job file.
•	 For DTP100: 61
•	 For PDTS: 17

2.	 Use subsequent box numbers for the secondary 
DDBC1200s:
•	 For DTP100: 62, 63, etcetera
•	 For PDTS: 18, 19 etcetera

3.	 Add the devices to the job file. Make sure there’s only 
one master channel in each Logical Channel. 

Figure 9. System view with DTP100

Figure 10. System view with PDTS

	 D.4	 Onsite commissioning
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Setup secondary DDBC1200s
1.	 Select the first secondary DDBC1200 controller.
2.	 Open the tab Outputs and select the checkbox 

Duplicate for all channels.
3.	 Repeat for all other secondary DDBC1200 controllers.

D.4.4	 Finalize configurations
1.	 Select either a DDBC or DDRC controller.
2.	 Set the Base Link Area (BLA) to the following scheme:

•	 Sales Floor: BLA 2
•	 Storage Area/Back of House: BLA 3
•	 Outdoor (if applicable): BLA 4

3.	 Repeat for all DDBC or DDRC controllers.
4.	 On the PDDEG-S Site Gateway, create a metric 

“Device Online Status”. Upload all configuration data 
to the Site Gateway.

5.	 Right-click each device and select Save To Device. 
Select Resave all device data and click OK.

6.	 Save the job file to the cloud. Keep a backup of it on 
your local computer.

Figure 11. Outputs tab of secondary DDBC1200 in a system with DTP100

Figure 12. Outputs tab of secondary DDBC1200 in a system with PDTS

	 D.4	 Onsite commissioning
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D.4.5 Install UI on the touchscreen

For DTP100
1.	 Use a Windows PC to format the USB thumb drive. 

Select as File system: FAT.

	 Important
Don’t format the USB thumb drive with FAT32.

	 Note
In case you’re using a USB thumb drive with a larger 
memory than 4 GB, see the Knowledge Base with 
instructions how to format that device with FAT, or 
submit a C4CS ticket.

2.	 Create a folder Content. Copy the content files of 
the UI package file directly in this folder.

	 D.4	 Onsite commissioning
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3.	 Use the USB adapter to insert the USB thumb drive 
into the port USB ACC located at the top left of the 
touchscreen.

4.	 Press the Reset button to reboot the device.
	 The installation process starts automatically; the 

message Copying Content Files shows on the screen.

	 Note
It takes about two minutes to complete the 
installation.

5.	 Remove the USB adapter and USB thumb drive and 
attach the front panel.

5

	 D.4	 Onsite commissioning
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For PDTS
1.	 Connect the PC to the system using the DTK622 PC 

node. 

	 Note
Make sure the IP address of the PDTS is accessible 
for the PC.

2.	 Right-click the PDDEG-S and select Upload Custom 
Web Pages.

3.	 Select Select a zip file to upload, select the UI 
package file and click OK.

4.	 Select the Delete existing web pages checkbox and 
click Start.

	 Note
It takes only a few seconds to upload the files, after 
which the PDTS shows the new Local Control UI.

3

4

	 D.4	 Onsite commissioning
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